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Вступ 

Виконання лабораторних робіт з дисципліни «Комп`ютерна 

інженерна графіка та 3D моделювання» дасть можливість 

здобувачам вищої освіти здобути знання та практичні навики 

щодо сучасних наукових концепцій, понять, методів 

комп’ютерної інженерної графіки, технологій 3D моделювання, а 

також застосовування сучасних комп’ютерних програм для 

інженерного конструювання та 3D моделювання. 

Методичні вказівки до виконання лабораторних робіт з 

навчальної дисципліни «Комп`ютерна інженерна графіка та 3D 

моделювання» містять необхідний матеріал для здобуття 

студентами практичних навиків використання сучасних систем 

конструювання, проектування та моделювання при розробці 

різноманітної конструкторської та проектної документації. Під 

час виконання лабораторних робіт студенти здобудуть досвід, 

який допоможе при виконанні реальної розробки систем 

автоматизації та робототехніки різних галузей промисловості.  

При виконанні лабораторних робіт студенти використовують 

ліцензійне програмне забезпечення від корпорації Autodesk, 

зокрема: AutoCAD, AutoCAD Electrical, Inventor та Fusion, які 

надані у відповідності до програми співпраці з навчальними 

закладами 
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Лабораторна робота 1 

Розробка простих графічних об’єктів у програмі AutoCAD 

 

Мета роботи: Ознайомитися з основними правилами 

розробки та оформлення креслень. Набути практичні навиків з 

оформлення креслення в середовищі програми AutoCAD. 

Навчитися створювати креслення та заповнювати основний 

напис креслення. 

 

Теоретичні відомості 

Основні правила оформлення креслення. При оформленні 

будь-якого конструкторського креслення (кресленика) слід 

дотримуватись таких правил: 

1. Креслення виконують на аркушах паперу визначених 

розмірів (формату), які встановлені міжнародним стандартом 

оформлення аркушів ISO 216 (див. Додатки. Додаток 1 до 

лабораторної роботи 1). Міжнародний стандарт на паперові 

формати ISO 216 заснований на метричній системі мір і походить 

від формату паперового листа, що має площу в 1 м² (розмір А0). 

Всі формати паперу ISO мають одне і те ж відношення сторін, це 

відношення приблизно дорівнює 1:1,4142. Формат ISO 216 

складається з трьох серій форматів (з близькими розмірами для 

однакових номерів): 

А - за основу прийнята площа в 1 м² для максимального 

аркуша серії. 

В - за основу прийнята довжина в 1 м для короткої сторони 

максимального аркуша серії. 

С - формати конвертів для листів серії А (розміри більші 

приблизно на 9%). 

2. Формат листа на кресленні визначається розміром 

зовнішньої рамки, що виконується тонкою лінією (рис. 1.1). 

Внутрішня рамка виконується суцільною основною лінією на 

відстані 20 мм від лівої сторони зовнішньої рамки і на відстані 

5 мм від решти сторін (див. Додатки. Додаток 2 до лабораторної 

роботи 1). 
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Рис. 1.1. Загальний вигляд рамок креслення 

 

3. Креслення оформлюють за допомогою спеціальної таблиці, 

яку наносять у внутрішньому полі аркушу праворуч знизу, яку 

називають кутовим штампом, або основним написом, а також 

додатковими графами (рис. 1.2). Державним та міжнародними 

стандартами встановлено форму, розміри, зміст, розташування 

граф основного напису, а також розміри рамок на кресленнях і 

схемах. Рамку і графи виконують суцільною основною лінією, а 

кутовий штамп суцільною товстою та суцільною тонкою лініями 

(рис. 1.3), зразки ліній наведені у Додатках (див. Додаток 3 до 

лабораторної роботи 1). 

 

 
Рис. 1.2. Вигляд рамок на кресленні горизонтального 

компонування: 1 – кутовий штамп, 2 – додаткові графи 
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4. Формати (за винятком А4), можуть компонуватися, як 

горизонтально, так і вертикально. Формат А4 компонується лише 

вертикально. 

5. У правому нижньому куті аркуша міститься основний 

напис (кутовий штамп), розміри якого згідно з ГОСТ 2.104-2006 

наведені на рис. 1.3. 

 

 
а) 

 
б) 

Рис. 1.3. Розміри кутового штампу згідно з ГОСТ 2.104-2006: а) 

пристосований для навчальних закладів, б) стандартний 

 

Варто зауважити, що розташування рамки кутового штампу на 

форматі А4 повинно заповнювати весь простір нижньої частини 

аркуша. 

У графах штампу (номери граф на рис. 1.3 (а) наведені в 

дужках) вказується:  

(1) – назва кресленика відповідно до змісту роботи; 

(2) – назва навчального закладу та, шифр групи; 

(3) – номер варіанту (шифр студента, № залікової книжки);  
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(4) – прізвища виконавця та перевіряючого; 

(5) – підписи осіб, прізвища яких зазначені в графі 4;  

(6) – дата виконання; 

(7) – матеріал з якого виготовлено деталь (якщо потрібно);  

(8) – маса деталі (якщо потрібно); 

(9) – мірило зображення (масштаб); 

(10) – порядковий номер аркуша (за умови виконання 

кресленика на кількох аркушах); 

(11) – загальна кількість аркушів у роботі (за умови виконання 

кресленика на кількох аркушах). 

4. Усі написи на креслениках виконуються креслярським 

шрифтом, розміри якого та накреслення літер, цифр та знаків 

встановлює ГОСТ 2.304-81 (див. Додатки. Додаток 4 до 

лабораторної роботи 1). Згідно з вимогами стандарту 

застосовують шрифт без нахилу та з нахилом під кутом 75° до 

горизонту. На креслениках усі написи рекомендовано виконувати 

з нахилом літер, цифр та знаків. 

5. Кресленики виконують дотримуючись певних пропорцій, 

тобто масштабу (ДСТУ 2.307:2013). На аркушах формату А4 ці 

написи роблять вздовж короткої сторони аркуша, а на аркушах 

інших форматів вони можуть бути орієнтовані, як уздовж 

короткої, так і вздовж довгої сторони аркуша. Текстові написи 

завжди наносяться паралельно основним. 

Програма AutoCAD - це сучасна система проектування для 

створення креслень і тривимірних моделей, вона є ефективним 

інструментом для виконання проектних робіт завдяки 

універсальним можливостям та спеціалізованим функціям, які 

призначені для створення проєктів різних галузей промисловості. 

У AutoCAD використовується інтуїтивно зрозумілий 

інтерфейс. Інтерфейс розділений на кілька блоків: панель 

швидкого доступу, верхній блок інструментів, робочий простір, 

командний рядок, рядок стану (рис. 1.4). Будь-який користувач 

може налаштувати інтерфейс спеціально для себе. 
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Рис. 1.4. Зовнішній вигляд програми AutoCAD в режимі 

двовимірних креслень 
 

Використання графічних примітивів у програмі AutoCAD. 

Графічний примітив – це попередньо визначений основний 

геометричний елемент, за допомогою якого будуються складніші 

моделі. Програма AutoCAD використовує великий набір 

примітивів (рис. 1.5): точки, відрізки, кола, дуги, полілінії, 

мультилінії (ламана лінія, сегменти якої складаються з декількох 

паралельних відрізків), сплайни (гладкі криві, які проходять 

через заданий набір точок), тексти, блоки (іменований об’єкт, 

сформований з декількох примітивів), еліпси, багатокутники, 

фігури (частина площини, обмежена трьома або чотирма 

відрізками), прості тіла і т. д. Загальні властивості всіх 

примітивів: належність до конкретного шару побудови, колір, 

тип лінії і товщина. 
 

 
Рис. 1.5. Розташування основних графічних примітивів у 

підменю-стрічці (панельне меню)  
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Особливості використання графічного примітиву Відрізок 

(Line). Для побудови відрізка можна використати один зі 

способів: 

- Набрати з клавіатури команду: _line (ОТРЕЗОК)  

- Викликати з меню: Draw > Line (Рисование > Линия) – 

класичний AutoCAD 

- Натиснути кнопку на панелі інструментів:  

Щоб побудувати відрізок, необхідно вказати координати двох 

точок – початкової і кінцевої. При використанні команд 

(командний рядок) будується одинарний відрізок або 

послідовність відрізків. При побудові послідовності відрізків 

кінцева точка попереднього відрізка є початковою для 

наступного. Для побудови відрізка по координатах необхідно 

виконати таку послідовність кроків: 

1. Введіть команду одним із вище перерахованих способів. 

2. На запит системи Specify first point (Первая точка) ввести 

координати початкової точки одним з таких способів: 

- інтерактивне (динамічне) введення – помістити покажчик у 

вигляді перехрестя в точці, що має потрібні координати і 

натиснути ліву кнопку миші; 

- ввести координати початкової точки з клавіатури; 

- натиснути клавішу Enter, в цьому випадку, як початкову 

точку система автоматично вибере останню точку відрізка, 

побудованого попередньою командою або видасть повідомлення 

про помилку, якщо така точка відсутня. 

3. На запит системи Specify next point or [Undo] (Следующая 

точка или [оТменить]) ввести координати кінцевої точки одним 

з таких способів: 

- помістити покажчик у вигляді перехрестя в точці, що має 

потрібні координати і натиснути ліву кнопку миші; 

- ввести координати кінцевої точки з клавіатури. 

4. На запит системи Specify next point or [Undo] (Следующая 

точка или [оТменить]) виконати одну з таких дій: 

- завершити виконання команди, для цього натисніть клавішу 

Enter; 

- ввести координати кінцевої точки наступного відрізка одним 
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із способів, описаних у третьому кроці; 

5. На запит системи Specify next point or [Close/Undo] 

(Следующая точка или [Замкнуть/оТменить]) виконати одну з 

таких дій: 

- ввести координати кінцевої точки наступного відрізка одним 

із способів, описаних на третьому кроці; 

- завершити виконання команди одним із способів: 

a) натиснути клавішу Enter; 

б) ввести опцію Close (Замкнуть) з клавіатури, також 

доступна при натисканні правої кнопки миші. При цьому буде 

побудований відрізок, який сполучає останню точку з 

початковою точкою першого відрізка. Таким чином, побудуємо 

замкнутий контур; 

в) якщо не завершено виконання команди, то п’ятий крок 

повторюється необхідну кількість раз. 

Також можна вказувати наступну точку задавши мишкою 

напрям і ввівши у елемент швидкого набору конкретну відстань. 

Перемикання між елементами швидкого вводу можна 

здійснювати клавішею Tab (рис. 1.6): 

 

 
Рис. 1.6. Використання швидкого вводу параметрів лінії в 

AutoCAD 

 

Вага (товщина) ліній. Різні елементи креслення при 

виведенні на друк можуть мати різну вагу (товщину ліній). 

Здійснити вибір необхідного значення можна у вікні Line weigh 

tstyle (Вес линии), що з'являється при натисканні миші в рядку 

шару на поле Lineweight (Параметры весов линии) (рис. 1.6) або 

зі списку з відповідним ім'ям на панелі Свойства. 
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Рис. 1.6, а. Редагування параметрів лінії 

 

Типи ліній. Тип ліній обирається натисканням ЛК миші на 

відповідному полі в рядку шару (меню Слои). Якщо ж потрібний 

тип ліній відсутній, його потрібно дозавантажити. Для цього 

натиснути на елемент типу ліній шару і у вікні Выбор типа линий 

завантажуєм потрібний тип лінії. Після цього він з’явиться у 

переліку типів ліній (рис. 1.6, б). 

 

 
Рис. 1.6, б. Вибір типів лінії та додавання відсутніх ліній 

 

Об’єктна прив’язка. При роботі над кресленнями можна 

включати і виключати режими, що полегшують виконання 

побудов. Одним з таких режимів є режим об’єктної прив’язки 

(можна ввімкнути ввівши команду ПРИВЯЗКА (osnap), або 

використовуючи функціональну клавішу F3), який дозволяє 

зв’язувати точки новостворюваного об’єкта з точками раніше 
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створеного. Точками прив’язки можуть бути кінцеві або 

центральні точки об’єктів, точки явного або передбачуваного 

перетину і т. д. Вказівка необхідних точок виконується без 

обчислення їх абсолютних координат. При включеному режимі 

об’єктної прив’язки необхідно вибрати спосіб прив’язки і 

помістити покажчик миші поблизу об’єкта. Координати 

потрібної точки будуть визначені автоматично. 

Об’єктна прив’язка використовується при виконанні операцій 

креслення і редагування у відповідь на запрошення програми 

задати наступну точку. Щоб обрати об’єкти для прив’язки слід 

використати діалогове вікно Параметры объектной прив’язки, 

яке можна відкрити натиснувши на кнопку  Привязка курсора 

к опорным точкам в 2D, що знаходиться в правому нижньому 

куті робочого поля AutoCAD у рядку стану (рис. 1.7): 

 

 
Рис. 1.7. Вибір об’єктів для прив’язки 

 

Параметри Объектная привязка, які можна змінювати 

перераховані нижче (великими літерами виділені скорочення 

параметрів, які можна вводити з клавіатури у командниму рядку 

англыйською мовою): 

 ENDpoint (Конточка) – визначає координати кінцевих 

(крайніх) точок об’єктів (відрізка або дуги); 

 MIDpoint (Середина) – визначає координати точки 

середини відрізка, дуги, полілінії або мультилінії; 
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 CENter (Центр) – визначає координати точки центра кола, 

дуги або еліпса; 
 NODe (Узел) – визначає координати точкових об’єктів; 
 QUAdrant (Квадрант) – визначає координати квадрантних 

точок – точок перетину координатних осей з колом, дугою або 

еліпсом; 

 INTersection (Пересечение) – визначає координати точки 

перетину двох ліній, ліній з дугою або колом, двох кіл і/або дуг, 

сплайнів, меж області; 

 EXTension (Продолжение) – визначає координати точки на 
уявному продовженні ліній і дуг; 

 INSertion (Твставки) – визначає координати точки вставки 

тексту, атрибута, форми, визначення атрибута або блоку; 

PERpendicular (Нормаль) – визначає координати точки 

на лінії, колі, еліпсі, сплайні або дузі, яка при приєднанні до 

останньої точки створює нормаль до вибраного об’єкта; 

 TANgent (Касательная) – визначає координати точки на 

колі або дузі, яка при з’єднанні з останньою точкою створює 

дотичну до вибраного об’єкта; 

 NEArest (Ближайшая) – визначає координати точки на лінії, 

дузі або колі, яка є найближчою до позиції перехрестя графічного 

курсора; 

 APParent intersection (Кажущееся пересечение) – визначає 

координати точки уявного перетину ліній або меж областей; 

 PARallel (Параллельно) – визначає координати точки на 

лінії, яка при з’єднанні з останньою точкою утворює лінію, 

паралельну вибраному відрізку. 

Контролювати правильність вибору режиму прив’язки можна 

за допомогою контекстного меню вибору параметрів прив’язки 

(права клавіша миші, ПКМ), в якому вказано спосіб прив’язки 

(рис. 1.8). 
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Рис. 1.8. Контекстне меню вибору параметрів прив’язки 

 

Використання написів, виносок, таблиць та інших 

елементів оформлення креслень в AutoCAD. Для того, щоб 

вставляти написи виноски та оформляти таблиці на кресленнях, 

наприклад, заповнити рамки основного напису, використовують 

шрифти, які в прогамі AutoCAD можна настроювати та 

редагувати у меню «Аннотации». Вибір необхідного шрифту 

здійснюють одним зі способів, який зображений на рис. 1.9. 
 

 
а) 

 
б) 

Рис. 1.9. Вигляд меню Аннотации на головному екрані (а) та 

розгорнутий вигляд панелі Аннотации (б) 
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Об'єкти анотацій містять розміри, примітки та інші 

пояснювальні позначення або об'єкти інших типів, зазвичай 

використовувані для додавання різноманітної інформації до 

креслення. Вони містять інформацію про елемент, наприклад 

довжину стіни, діаметр кріпильної деталі або виносний елемент 

вузла. Як правило, об'єкти анотацій масштабуються інакше, ніж 

види креслення, і масштаб залежить від того, який вигляд вони 

мають мати під час друку. Для того щоб керувати стилями тексту 

(вибір шрифту), який буде нанесено на кресленнях потрібно 

скористатися опцією: Аннотации > Standart > Управление 

стилями текста…(рис. 1.10).  

 

 
Рис. 1.10. Вигляд меню для налаштування стилю тексту, який 

буде відображатися на кресленні 

 

Написи на кресленнях виконують креслярським шрифтом 

відповідно до ГОСТ 2.304-81. Розмір шрифту визначає висота h 

великих літер в міліметрах. Приклад заповнення основного 

напису креслення креслярським шрифтом у програмі AutoCAD 

показано на рис. 1.11. 
 

 
Рис.1.11. Приклад заповнення рамки основного напису  
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Налаштування параметрів сторінки креслення. 

Починаючи роботу над кресленням, необхідно передбачити 

спосіб розміщення об’єкта та виведення його на друк для 

відповідного формату. За замовчуванням при запуску програми 

AutoCAD або створенні нового креслення видима область його 

простору значно менша, ніж може знадобитися розробнику.  

Максимальна область, або візуальний доступ, до якого може 

бути швидко забезпечений екранними операціями AutoCAD, 

підлягає налаштуванню користувачем і називається лімітами 

креслення. Для задання розмірів креслення (лімітів) необхідно їх 

вибрати в системному меню за послідовністю: Файл > Печать 

Параметры листа > Диспетчер параметров листа. У цьому 

меню потрібно вибрати опцію Редактрировать..., після цього 

виконуємо налаштування Параметры листа. В діалоговому вікні 

(рис. 1.12) встановити розміри аркуша, одиниці виміру та інші 

налаштування. 

 

 
Рис. 1.12. Діалогове вікно налаштування Параметры листа 

 

 



 

18  

Програма роботи 

1. Розглянути основні правила оформлення креслень різних 

форматів. 

2. Навчитися використовувати програму AutoCAD для 

розробки та оформлення креслень (рамки та основний напис). 

 

Порядок виконання роботи 

1. Розглянути правила оформлення креслень у програмі 

AutoCAD з теоретичних відомостей. 

2. Створити новий файл креслення та новий проект у програмі 

AutoCAD. Для цього запустіть програму та виберіть Начало > 

Выбор шаблона > ACADiso.dwt або інший підхожий шаблон. 

Шаблон – графічний файл з розширенням .dwt. Цей файл містить 

інформацію про розміри креслення, прийняті одиниці 

вимірювання, параметри шарів і настроювань режиму креслення 

(acadiso.dwt – оптимальний шаблон-стандарт для України).  

3. Виконати налаштування параметрів листа, що буде 

виводиться на друк за допомогою меню Параметры листа (рис. 

1.11). 

4. За допомогою найпростіших графічних примітивів 

Отрезок (Line), використовуючи вкладку Рисование та об’єктні 

прив’язки накреслити рамку формату, заданого викладачем 

(Додаток 1, Серія А0-А4) з кутовим штампом визначеного 

розміру. Варіант А0 для студентів з 1 по 5 в списку; А1 для 

студентів з 6 по 10 в списку; А2 для студентів з 11 по 15 в списку; 

А3 для студентів з 16 по 20 в списку; А4 для студентів з 21 по 28 

в списку.  

5. Заповнити кутовий штамп ввівши всі необхідні дані у 

відповідності до рис. 1.3, при цьому потрібно використовувати 

шрифт GOST type A (курсив) для студентів з 1 по 10 в списку 

групи та GOST type В (курсив), відповідно для студентів з 11 по 

20 в списку групи. 

6. Зберегти файл креслення. Виконується командою File > 

Save As (Файл > Сохранить как) або командою File > Save (Файл 

> Сохранить). Після виклику команди з’являється діалогове 

вікно Сохранить как, в якому вибирається папка і надається ім’я 
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файлу. Зміни, внесені у раніше створений файл, зберігаються 

командою File > Save (Файл > Сохранить).  

7. Виконане завдання оформити у вигляді звіту на 

стандартних аркушах формату А4. Звіт має бути підготовлений 

так, як на друк. Додатково зберегти у окремий файл результат 

виконання побудови рамки листа заданого формату з заповненим 

кутовим штампом зберегти та надати на перевірку разом зі звітом 

у форматі .dwg. 

Зауваження. Для оформлення (друкування) креслення на 

окремому аркуші (А4-А0) можна використати функцію експорт 

креслення в PDF-формат. При цьому потрібно перейти за 

посиланням: Файл > Экспорт > PDF.  

 

Вимоги до оформлення звіту  

Звіт повинен містити: 

- титульний аркуш; 

- мету роботи; 

- програму роботи; 

- скріншоти виконання основних етапів побудови, які описані 

у порядку виконання роботи; 

- креслення виконання рамки та заповненого основного 

напису; 

- висновок. 

 

Контрольні запитання. 

1. Як оформлюють креслення? 

2. Що вказується у графах штампу основного напису? 

3. Як зобразити графічні примітив Відрізок? 

4. Як використовуються об’єктні прив’язки? 

5. Які основні елементи робочого столу програми AutoCAD? 

6. Що таке шаблон у програмі AutoCAD? 
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Лабораторна робота 2 

Побудова двовимірних графічних об’єктів в програмі 

AutoCAD 

 

Мета роботи 

Навчитися будувати двовимірні графічні об’єкти за 

допомогою геометричних примітивів з використанням 

глобальних та локальних прив’язок. Набути практичні навики 

двовимірного комп’ютерного геометричного моделювання в 

програмі AutoCAD.  

 

Теоретичні відомості 

Розробка графічних примітивів. Графічний примітив – це 

попередньо визначений основний геометричний елемент, за 

допомогою якого будуються складніші моделі. У програмі 

AutoCAD наявний великий набір графічних примітивів: точки, 

відрізки, кола, дуги, полілінії (неперервна послідовність відрізків 

і дуг), мультилінії (ламана лінія, сегменти якої складаються з 

декількох паралельних відрізків), сплайни (гладкі криві, які 

проходять через заданий набір точок), тексти, блоки (іменований 

об’єкт, сформований із декількох примітивів), еліпси, 

багатокутники, фігури (частина площини, обмежена трьома або 

чотирма відрізками), прості тіла і т. д. Розташування основних 

графічних примітивів у підменю-стрічці (панельне меню) 

Рисование детально описано у попередній лабораторній роботі.  

Особливості використання графічних примітивів у 

програмі AutoCAD. Використання графічного примітиву 

Відрізок (Line) розглянуто у попередній лабораторній роботі. 

Полілінія (Polyline). Для побудови цього графічного примітиву 

можна використати один зі способів: 

- Набрати з клавіатури команду: _pline (ПЛИНИЯ); 

- Викликати з меню: Draw > Polyline (Рисование > 

Полилиния); 

- Натиснути на кнопку на панелі інструментів . 

Полілінія складається із послідовності лінійних та дугових 

сегментів. Кожен сегмент може мати визначену ширину. 

Значення ширини в початковій точці сегмента може відрізнятись 



 

21  

від значення в кінцевій точці. При побудові полілінії необхідно 

визначити початкову точку у відповідь на запит системи Specify 

start point (Начальная точка). Далі стають доступними 

параметри у командному рядку AutoCAD під час наступного 

запиту системи Следующая точка или 

[Дуга/Замкнуть/Полуширина/длИна/Отменить/Ширина]: 

- _arс (Дуга) – створення дугового сегмента полілінії; 

- _close (Замкнуть) – з’єднує кінцеву точку полілінії з її 

початком прямолінійним сегментом; 

- _halfwidth (Полуширина) – задає половину ширини сегмента 

полілінії в початковій та кінцевій точці; 

- _length (Длина) – створює сегмент полілінії заданої довжини 

того ж напряму, що і попередній; 

- _undo (Отменить) – видаляється останній побудований 

сегмент; 

- _width (Ширина) – задає ширину сегмента полілінії в 

початковій та кінцевій точці. 

В AutoCAD полілінія вважається єдиним об’єктом. Для 

редагування полілінії використовується команда _poledit 

(ПОЛРЕД). При цьому, досить часто полілінію потрібно розбити 

на окремі об’єкти використовуючи команду _explode 

(РАСЧЛЕНИТЬ). Створену лінію командою _line можна 

перетворити в полілінію командою _ poledit. 

Коло (Circle). Для побудови цього графічного примітиву 

можна використати один зі способів: 

- Набрати з клавіатури команду: _circle (КРУГ); 

- Викликати з меню: Draw > Circle (Рисование > Круг); 

- Натиснути кнопку на панелі інструментів     . 

Для побудови кола необхідно виконати такі дії: 

- ввести команду одним із вище перерахованих способів; 

- на запит системи Specify center point for circle or [3P/2P/Ttr 

(tan tan radius)] (Центр круга или [3Т/2Т/ККР (кас радиус)]) 

вибрати один із способів побудови кола. 

Коло можна побудувати наступними способами: 

1) вказати координати центра кола і розмір радіуса або 

діаметра: 
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- ввести координати центра кола; 

- на запит системи Specify radius of circle or [Diameter] (Радиус 

круга или [Диаметр]) ввести значення радіуса
 
або опцію D (Д); 

- якщо ввели опцію D (Д), то з’явиться запит Specify diameter 

of circle  (Диаметр круга), на який потрібно ввести значення 

діаметра. 

2) вказати координати трьох точок, які лежать на колі і не 

належать одній прямій: 

- ввести опцію 3Р (3Т), що відповідає вибору способу 

побудови кола по трьох точках; 

- далі по черзі ввести координати цих точок на відповідні 

запити системи: Specify first point on circle (Первая точка круга); 

Specify second point on circle (Вторая точка круга); Specify third 

point on circle (Третья точка круга). 

3) вказати координати двох точок, які є кінцями діаметра: 

- ввести опцію 2Р (2T), що відповідає вибору способу 

побудови кола по кінцевих точках його діаметра; 

- далі по черзі ввести координати цих точок на відповідні 

запити системи: Specify first end point of circle’s diameter (Первая 

конечная точка диаметра круга); Specify second end point of 

circle’s diameter (Вторая конечная точка диаметра круга). 

4) побудувати коло, яке торкається двох раніше побудованих 

об’єктів у вказаних точках: 

- ввести опцію Ttr (ККР). В цьому випадку коло стикається в 

двох точках з об’єктами, побудованими раніше; 

- системою буде  виданий  запит на  почергове  введення  

координат цих точок: Specify point on object for first tangent of 

circle (Укажите точку на объекте, задающую первую 

касательную); Specify point on object for second tangent of circle 

(Укажите точку на объекте, задающую вторую касательную); 

- ввести радіус кола у відповідь на запит системи Specify radius 

of circle (Радиус круга) або натиснути клавішу Enter. В цьому 

випадку радіус буде обчислений автоматично. 

Дуга (Arc). Для побудови цього графічного примітиву можна 

використати один зі способів: 

- Набрати з клавіатури команду: _arc (ДУГА); 
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- Викликати з меню: Draw > Arc (Рисование > Дуга); 

- Натиснути кнопку на панелі інструментів      . 

Дуга будується одинадцятьма способами, які розрізняються 

вибором і комбінацією параметрів, відображених у меню: Start 

(Начало) – початкова точка; Center (Центр) – центр дуги; End 

(Конец) – кінцева точка; Angle (Угол) – центральний кут; Chord 

Length (Длина) – довжина хорди; Direction (Направление) – 

напрям дотичної (вказується однією точкою і збігається з 

вектором, проведеним в цю точку з початкової точки); Radius 

(Радіус) – радіус дуги; 3 Points (3 Точки) – за трьома точками, що 

лежать на дузі; Continue (Продолжить) – побудова дуги як 

продовження попередньої лінії чи дуги. Початковою точкою і 

початковим напрямом будуть відповідно кінцева точка та 

кінцевий напрям попередніх дуги чи відрізка. При побудові дуги 

додатним вважається напрям побудови дуги проти годинникової 

стрілки. Змінити напрям побудови можна, ввівши від’ємне 

значення кута. При будуванні дуги з використанням параметра 

Довжина змінити напрям побудови можна, ввівши від’ємне 

значення хорди. 

Прямокутник (Rectang). Для побудови цього графічного 

примітиву можна використати один зі способів: 

- Набрати з клавіатури команду: _rectang 

(ПРЯМОУГОЛЬНИК); 

- Викликати з меню: Draw > Rectang (Рисование > 

Прямоугольник); 

- Натиснути кнопку на панелі інструментів       .   

Щоб побудувати прямокутник, потрібно вказати координати 

двох діагонально протилежних вершин. Прямокутник можна 

побудувати з заокругленнями (параметр Fillet (Сопряжение), 

необхідно вказати радіус заокруглення) або з фасками (параметр 

Chamfer (Фаска), слід вказати розмір фаски по горизонталі та по 

вертикалі). 

Еліпс (Ellipse). Для побудови цього графічного примітиву 

можна використати один зі способів: 

- Набрати з клавіатури команду: _ellipse (ЭЛЛИПС); 

- Викликати з меню: Draw > Ellipse (Рисование > Эллипс); 

- Натиснути кнопку на панелі інструментів        .    
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Еліпс можна побудувати, вказавши центр та радіус 

ізометричного кола або задавши початкову та кінцеву точку 

однієї осі і відстань від центра еліпса до кінця другої осі, тобто 

комбінацією параметрів, відображених у меню: 

- Center (Центр) – центр еліпса. Необхідно також вказати 

координати кінцевої точки осі і відстань від центра до кінцевої 

точки другої осі; 

- Axis endpoint (Ось, конец) – кінцева точка осі. При виборі 

даної опції (вона застосовується за замовчуванням) задаються дві 

кінцеві точки першої осі і точка, що вказує відстань від центра 

еліпса до кінця другої осі; 

- Arc (Эллиптическая дуга) – дозволяє створити еліптичну 

дугу. Додатковим параметром команди є Rotation (Поворот) – 

еліпс будується як проекція кола, що обертається навколо 

діаметра, визначеного заданими перед цим точками на площину 

креслення. 

При роботі над кресленнями можна включати і виключати 

режими, що полегшують виконання побудов. Одним з таких 

режимів є режим об’єктної прив’язки (можна ввімкнути ввівши 

команду _osnap, або використовуючи функціональну клавішу 

F3), який дозволяє зв’язувати точки новостворюваного об’єкта з 

точками раніше створеного. Детально про використання 

прив’язок розглядалося в лабораторній роботі 1. 

Редагування створених примітивів. Для виконання реальних 

креслень дуже часто доводиться редагувати побудовані за 

допомогою примітивів зображення. Для цього використовується 

вкладка-панель Редактирование . На цій вкладці 

знаходяться елементи редагування, які можна застосовувати для 

виконання команд: спряження, перенесення, відображення, 

обрізання та ін.  

Щоб виконати редагування створеного раніше зображення 

потрібно спочатку ввести параметри редагування за допомогою 

контекстного меню, а потім виконати саме редагування. 

Наприклад для виконання округлення кутів прямокутників 

використовуємо кнопку  «Сопряжение» на панелі 

Редактирование. Але перед тим, як виконати округлення 

потрібно з контекстного меню, яке активовується натисканням 
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ПКМ визначити параметри округлення та ввести необхідне 

значення, наприклад радіус (рис. 2.1, а). Після введення 

відповідного радіусу та натискання кнопки Enter на кресленні 

потрібно вибрати елементи округлення та виконати його (рис. 

2.1, б). Подібним чином виконуються інші команди з панелі 

Редактирование. 

 

  
а)                                 б) 

Рис. 2.1. Послідовність виконання команди Сопряжение  

 

Розміри на кресленнях наносять згідно з вимогами ДСТУ 

ГОСТ 2.307:2013 «Єдина система конструкторської 

документації. Нанесення розмірів і граничних відхилів». Розміри 

на кресленнях зазначають за допомогою розмірних ліній та 

розмірних чисел; лінійні розміри та їх граничні відхилення 

вказують на кресленнях у міліметрах без позначення одиниці, які 

зазначають обов’язково у тексті на полі креслення та в 

пояснювальній записці. Якщо розмір задано не у міліметрах, то 

одиницю вказують безпосередньо біля розміру або в технічних 

вимогах. Кутові розміри та граничні відхилення зазначають у 

градусах, хвилинах і секундах з позначенням одиниці (наприклад 

20°10'3"). 

Кожен розмір зазначають лише один раз і на тому зображенні 

де даний елемент деталі показано найбільш зрозуміло. Процес 

нанесення розмірів включає дві операції: 

1) проведення виносних і розмірних ліній 

2) написання розмірного числа. 
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Розмірну лінію, що показує межі вимірювання, проводять 

паралельно вимірюваному елементу і закінчують стрілками. 

Форму стрілки, приблизне співвідношення її елементів і товщину 

лінії видимого контуру слід зберігати на всьому кресленику (кут 

– 20°, довжина – 2,5÷3 мм). 

Виносні лінії є допоміжними, їх проводять від меж 

вимірювання, між ними проводять розмірні лінії. Виносні лінії 

повинні виходити за кінці стрілок розмірної лінії на 1...5 мм. 

Виносні лінії проводять від ліній видимого контуру, осьових, 

центрових і, в разі необхідності, від ліній невидимого контуру. 

Розмірні та виносні лінії виконують тонкими суцільними лініями 

товщиною S/З...S/2. 

Виносні лінії при нанесенні розміру прямолінійного відрізка 

проводять перпендикулярно до вимірюваного елемента (рис. 2.2, 

а); при нанесенні розміру кута: 

–  радіально (рис. 2.2, б); при нанесенні розміру дуги  

–  паралельно бісектрисі кута (рис. 2.2, в).  

У випадку ухилів і конусностей розмірні й виносні лінії 

проводять так, щоб разом з вимірюваною ділянкою вони 

утворювали паралелограм (рис. 2.2, г). 

       
а                       б                        в                      г 

Рис. 2.2. Приклади нанесення різних типів виносних і розмірних 

ліній 

 

Розміри, що стосуються одного і того ж конструктивного 

елемента (пазу, отвору тощо), рекомендується групувати і 

розміщувати в одному місці на тому зображенні, де форма даного 

елемента розкривається найповніше. Розміри двох симетрично 

розміщених елементів виробу (крім отворів) наносять лише один 

раз без зазначення їхньої кількості, групуючи всі розміри в 

одному місці (рис. 2.3). 
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Рис. 2.3. Приклад нанесення розмірів на симетричну деталь 

 

Розмірні числа та граничні відхилення не допускається 

розділяти або перетинати будь-якими лініями креслення. Не 

допускається розривати лінію контуру для нанесення розмірного 

числа та наносити розмірні числа в місцях перетину розмірних, 

осьових і центрових ліній. У місці нанесення розмірного числа 

осьові, центрові лінії та лінії штрихування треба переривати. 

Не допускається наносити розміри у вигляді замкненого 

розмірного ланцюга, тобто сукупності розмірів, що утворюють 

замкнений контур, окрім випадків, коли один із розмірів ланцюга 

вказано у вигляді довідкового без граничних відхилень. Не 

рекомендується проставляти на кресленні розміри невидного 

контуру, що зображений штриховими лініями. 

Нанесення розмірів в AutoCAD. Креслення деталі без 

нанесених на нього розмірів вважається незакінченим. Розміри 

повинні повністю визначати величину деталі. Їх повинна бути 

достатня кількість, але зайвих розмірів наносити також 

непотрібно. Можна проставляти розміри від загальної бази і 

утворювати розмірні ланцюжки. 

Нанесення розмірів виконують одним з двох методів. Перший 

полягає у тому, що після введення команди курсором мишки 

вказується об’єкт, розмір якого вимірюється і задається 

положення розмірної лінії. При використанні другого методу 

курсором миші вказуються початкові точки виносних ліній і 
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положення розмірної лінії. В останньому випадку 

рекомендується включити режим об’єктної прив’язки. 

Варіанти нанесення розмірів або їх редагування здійснюється 

за командою Dimensions (Размеры) в командному рядку, або за 

допомогою кнопок на панелі  Annotate > Dimensions
  
(Аннотации 

> Размеры) режиму Drawing & Annotation
 

(Рисование и 

аннотации): Annotate > Dimensions (Аннотации > Размеры) (рис. 

2.4). 

 

 
Рис. 2.4. Елементи розмірів при натисканні відповідної кнопки, 

що на панелі меню Аннотации 

 

У програмі AutoCAD використовуються асоціативні розміри, 

тобто при зміні об’єктів командами редагування елементи 

розмірів автоматично оновлюються. Вигляд розміру на кресленні 

залежить від вибраного стилю. За умовчанням пропонується 

стиль ISO-25, призначений для машинобудівельного креслення. 

AutoCAD надає можливість вносити зміни в існуючі стилі, а 

також створювати власні стилі. Від вибраного розмірного стилю 

залежить відображення виносних ліній, розмір і положення 

тексту, довжина і тип стрілок, базовий інтервал між розмірними 

лініями і т.ін. Керують процесом нанесення розмірів розмірні 

змінні, значення яких можна змінити відповідними командами 

або у діалоговому вікні Dimension Style Manager (Аннотации > 

ISO-25 > Управление размерными стилями…) створивши новий 

стиль або редагуючи існуючий (рис. 2.5). 
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Рис. 2.5. Діалогове вікно розмірних стилів Диспетчер размерных 

стилей 

 

Внесення змін в існуючий стиль відбувається у діалоговому 

вікні Modyfy Dimension Style (Изменение размерного стиля ISO-

25) (рис. 2.6). На відповідних вкладках даного вікна можна 

змінити значення розмірних змінних. Існуючий стиль 

редагується за допомогою кнопки Modyfy (Редактировать), для 

створення нового стилю натиснути кнопку New (Новый) після 

чого можна задати характеристики розмірів. 

 

 
Рис. 2.6. Внесення змін у розмірний стиль у діалоговому вікні  

Modyfy Dimension Style (Изменение размерного стиля ISO-25) 

 

На вкладці Lines (Линии) задається колір, товщина та інші 

характеристики розмірних та виносних ліній. На вкладці Symbols 

and Arrows (Символы и стрелки) вибирається тип та розмір 
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стрілок. На вкладці Text (Текст) вибираються параметри 

розмірного тексту: колір, стиль, вирівнювання. На вкладці Fit 

(Размещение) здійснюється управління взаємним розміщенням 

розмірних, виносних ліній та тексту, а також масштабом розмірів. 

На вкладках Primary Units (Основные единицы) та Alternate Units 

(Альт. Единицы) визначається формат одиниць вимірювання, 

задається точність. На вкладці Tolerance (Допуски) визначається 

формат та точність допусків. 

 

Програма роботи 

1. Розглянути основні правила виконання двовимірних 

графічних об’єктів. 

2. Навчитися використовувати програму AutoCAD для 

розробки двовимірних креслень.  

 

Порядок виконання роботи 

1. Розглянути правила виконання двовимірних графічних 

об’єктів та можливості розробки 2D-креслень у програмі 

AutoCAD з теоретичних відомостей. 

2. Вибрати 2D-модель згідно варіанту заданого викладачем. 

3.  Створити новий проект у програмі AutoCAD. Для цього 

запустіть програму та виберіть Начало > Выбор шаблона 

ACADiso.dwt або інший підхожий шаблон. 

3.1. Виберіть рамку відповідного формату (розроблена у 

попередній лабораторній роботі) та заповніть кутовий штамп 

відповідно до лабораторної роботи.  

Зауваження. Якщо креслення вибраної згідно варіанту деталі 

не підходить під розроблену на попередній лабораторній роботі 

рамку, наприклад рамка занадто мала, або занадто велика, то 

виберіть одну зі стандартних рамок з наявних у шаблонах 

AutoCAD заповнивши кутовий штамп. Для цього перейдіть за 

посиланням: Файл > Создать > Создание нового чертежа > 

Чертеж та виберіть один з варіантів оформлення. 

3.2. За допомогою поєднання основних графічних примітивів 

Відрізок, Полілінія, Коло, Прямокутник тощо, використовуючи 

кнопки на панельному меню Рисование, а також засоби 
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редагування на панели Редактирование побудувати деталь у 

відповідності до варіанту з Додатку 1. 

3.3. Перед виконанням всіх креслень налаштуйте властивості 

(товщини) ліній відповідності до ДСТУ. Суцільна основна лінія: 

0,5 - 1,4 мм; суцільна тонка лінія: s/2; штрих-пунктирна (осьова) 

s/2. Зміни параметрів ліній виконують за допомогою меню: 

Свойства > Вес линии. 

3.4. Виконати нанесення відповідних розмірів, попередньо 

налаштувавши виведення та відображення розмірів за 

допомогою меню Аннотации > Размеры. 

4. Результати виконання креслення оформити у вигляді звіту 

на стандартних аркушах формату А4. Креслення деталі виконати 

на окремому аркуші з рамкою та заповненим кутовим штампом. 

Додатково надати для перевірки виконаний файл у форматі .dwg. 

Зауваження. Для оформлення креслення на окремому аркуші 

(А3-А1) можна використати функцію експорт креслення в PDF-

формат. При цьому потрібно перейти за посиланням: Файл > 

Экспорт > PDF.  

 

Вимоги до оформлення звіту  

Звіт повинен містити: 

- титульний аркуш; 

- мету роботи; 

- програму роботи; 

- скріншоти виконання основних етапів побудови, які описані 

у порядку виконання роботи; 

- креслення виконання завдання на окремому аркуші з рамкою 

та заповненим основним написом; 

- висновок. 

 

Контрольні запитання. 

1. Як виконується побудова графічного примітиву лінія та 

полілінія? 

2. Як виконується побудова графічного примітиву дуга, коло 

та прямокутник? 

3. Як використовуються прив’язки? 

4. Як наносять розміри на кресленнях? 
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5. Як наносять розмірні числа на кресленнях? 

6. Як відбувається редагування розмірів? 
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Лабораторна робота 3 

Розробка 3D-моделей в програмі AutoCAD 

 

Мета роботи 

Навчитися виконувати 3D-моделі простих об’єктів 

використовуючи програму AutoCAD. 

 

Теоретичні відомості 

При конструюванні та розробці нових елементів систем 

автоматизації дуже часто потрібно виконувати креслення різних 

пристроїв, установок та агрегатів. Всі вони складаються з 

тривимірних моделей, які потім об’єднуються у складальні 

креслення. 3D-моделі можна будувати на базі елементарних 

форм: паралелепіпедів, конусів, циліндрів, сфер, торів і клинів, а 

також шляхом перетворення ескізів у 3D-моделі. Складні 3D-

моделі створюються шляхом комбінування елементарних 

об’єктів та форм. Разом з тим, елементарні форми можна 

об'єднувати, віднімати і перетинати, тобто брати тільки спільну 

займану декількома тілами частину об'єму. Подальша 

модифікація об’ємних тіл може здійснюється шляхом спряження 

їх граней і зняття фасок, або інших операцій.  

В програмі AutoCAD застосовується різні операції та функції, 

які дозволяють створювати 3D-моделі. Також, AutoCAD має 

команди, за допомогою яких 3D-моделі можна модифікувати. 

Для побудови 3D-моделей у програмі AutoCAD на вкладці 

«Переключение рабочего пространства» необхідно вибрати 

режим (вкладку) для роботи з тілами і поверхнями у 

тривимірному просторі «3D-моделирование», після цього 

інтерфейс програми стане пристосованим для роботи з 

тривимірними моделями, як показано на рис. 3.1.   
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Рис. 3.1. Елементи інтерфейсу програми AutoCAD в режимі 

розробки 3D-моделей 

 

Способи побудови 3D-об’єктів. Площина екрану у програмі 

AutoCAD збігається з площиною XY системи координат вона 

називається площиною побудов. Будуючи двовимірні об’єкти, 

можна змінювати їх рівень, тобто керувати переміщенням 

площини побудов вздовж осі Z. Спостерігати за зміною рівня 

площини можна при переході до ізометричних видів. Змінити 

рівень площини побудови можна введенням додатного або 

від’ємного числа у поле Elevation (Уровень). Наприклад, ввівши 

значення 100, отримаємо зсув об’єкта вгору вздовж осі Z, 

від’ємне значення у полі призведе до зміщення об’єкта вниз 

вздовж осі Z.  

Витискання (Выдавить) - це один з простих способів 

створення тривимірних об’єктів (рис. 3.2). Витисканням 

називається зміна властивості двовимірного об’єкта (товщина 

або висота). Також виконати операцію можна, вибравши з 

контекстного меню об’єкта команду Properties (Свойства) і 

змінивши значення у полі Thickness (Высота 3D). Вводити можна 

як додатне так і від’ємне значення. У першому випадку об’єкти 

витискаються вздовж додатного напрямку осі Z, в другому 

вздовж від’ємного. На криволінійній частині об’єктів система 

виводить деяку кількість твірних ліній. 
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Рис. 3.2. Побудова 3D-об’єкта за допомогою команди 

«Выдавить» 

 

Тривимірні об’єкти в AutoCAD можна представити 

каркасами, поверхнями і твердотільними моделями. Каркасні 

моделі представлені лише ребрами граней являють собою прозорі 

об’єкти. Створюється каркасна модель командами побудови 

двовимірних графічних примітивів, до яких належать відрізки, 

точки, кола, дуги тощо, але при цьому задавати потрібно 

тривимірні координати точок X, Y, Z. 

Поверхні мають непрозорі грані але порожні всередині, 

представлені оболонкою без наповнення. Такі поверхні можуть 

представлятися не лише ребрами, вони мають також непрозорі 

грані. Крім того, поверхня може бути представлена сіткою, тобто 

низкою послідовно розташованих граней, що мають спільні 

ребра. Твердотільний об’єкт – суцільний, має об’єм і масу.  

Побудову 3D-тіл у AutoCAD можна виконати на основі 

примітивних форм: паралелепіпедів, конусів, циліндрів, сфер, 

торів і клинів, а також шляхом витиснення 2D-об’єктів або 

обертання їх довкола осі. Складні просторові тіла створюються 

шляхом комбінування елементарних. Елементарні форми можна 

об'єднувати, віднімати і перетинати (тобто брати тільки спільну 

займану декількома тілами частину об'єму). 
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Подальша модифікація тіл здійснюється шляхом спряження їх 

граней і зняття фасок. Підтримується ряд функцій, пов’язаних з 

редагуванням граней тіл, що не потребує побудови додаткових 

геометричних об’єктів і виконання логічних операцій. В 

AutoCAD також є команди, за допомогою яких тіло можна 

розрізати на частини або здійснити розріз площиною.  

Основні 3D-тіла у програмі AutoCAD знаходяться на вкладці 

«Моделирование»: 

Паралелепіпед (Box). Способи введення команди: 

- набрати з клавіатури команду: _box (ЯЩИК); 

- викликати з меню: Draw > Solids > Box (Рисование > 

Моделирование > Ящик); 

- натиснути на кнопку  на панелі інструментів Solid > 

Primitive > Box (Фигура > Примитив > Ящик).  

Паралелепіпед визначається точками кутів основи 

паралелепіпеда і висотою або центром, висотою і трьома 

розмірами – довжиною, шириною, висотою. Основа 

паралелепіпеда завжди паралельна площині XY поточної UCS 

(ПСК). 

Конус (Cone). Способи введення команди: 

- набрати з клавіатури команду: _cone (КОНУС); 

- викликати з меню: Draw > Modeling > Cone (Рисование > 

Моделирование > Конус); 

- натиснути на кнопку  панелі інструментів Solid > Primitive 

> Polysolid > Cone (Фигура > Примитив > Политело > Конус). 

Конус будується з еліптичною або круговою основою і 

визначається положенням центра, радіусом основи і висотою. За 

умовчанням основа конуса розташовується в площині XY 

поточної UCS (ПСК). Висота конуса (може бути як додатною, так 

і від’ємною) паралельна до осі Z. Положення вершини конуса 

визначає його висоту і орієнтацію. За замовчуванням висота 

перпендикулярна основі. Змінити орієнтацію конуса можна, 

якщо вибрати опцію Axis endpoint (Конечная точка оси) і задати 

координати вершини конуса. 

Для побудови зрізаного конуса, або конуса орієнтованого під 

певним кутом потрібно скористатись опцією Top radius (Радиус 
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верхнего основания) або спочатку намалювати круг, а потім 

командою видавлювання виконати витиснення зі звуженням під 

кутом до осі Z. 

Піраміда (Pyramid). Способи введення команди: 

- набрати з клавіатури команду _pyramid (ПИРАМИДА); 

- викликати з меню: Draw > Modeling > Pyramid (Рисование > 

Моделирование > Пирамида); 

- натиснути на кнопку  на панелі інструментів Solid > 

Primitive > Polysolid > Pyramid (Фигура > Примитив > Политело 

> Пирамида). 
За замовчуванням піраміда визначається за центром базової 

точки, точкою посередині кромки і точкою, яка задає висоту. 

Циліндр (Cylinder). Способи введення команди: 

- набрати з клавіатури команду: _cylinder (ЦИЛИНДР); 

- викликати з меню: Draw > Modeling > Cylinder (Рисование 

> Моделирование > Цилиндр); 

- натиснути на кнопку  на панелі інструментів Solid > 

Primitive > Cylinder (Фигура > Примитив > Цилиндр). 

Основа циліндра може бути круговою або еліптичною, 

розташовується в площині XY поточної UCS (ПСК). Для 

побудови циліндра необхідно визначити положення центра 

основи, радіус або діаметр основи. Висота циліндра задається 

введенням конкретного значення. 

Сфера (Sphere). Способи введення команди: 

- набрати з клавіатури команду: _sphere (СФЕРА); 

- викликати з меню: Draw > Modeling > Sphere (Рисование > 

Моделирование > Сфера); 

- натиснути на кнопку  на панелі інструментів Solid > 

Primitive > Sphere (Фигура > Примитив > Сфера). 

Сфера будується після визначення положення центра і 

радіуса. Основа кулі розташовується в площині XY поточної UCS 

(ПСК). 

Тор (Torus). Способи введення команди: 

- набрати з клавіатури команду: _torus (ТОР); 
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- викликати з меню: Draw > Modeling > Torus (Рисование > 

Моделирование > Тор); 

- натиснути на кнопку  на панелі інструментів Solid > 

Primitive > Polysolid > Torus (Фигура > Примитив > Политело > 

Тор). 
Твердотілий тор має центр на початку координат і вісь 

паралельну осі Z. Площина XY поточної UCS (ПСК) ділить тор на 

дві рівні частини в подовжньому перетині. Тор будується після 

визначення положення центра, радіуса кола, що проходить через 

центр труби і радіуса труби. 

Клин (Wedge). Способи введення команди: 

- набрати з клавіатури команду: _wedge (КЛИН); 

- викликати з меню: Draw > Modeling > Wedge (Рисование > 

Моделирование > Клин) – класичний AutoCAD; 

- натиснути на кнопку  на панелі інструментів Solid > 

Primitive > Polysolid > Wedge (Фигура > Примитив > Политело 

> Клин). 
Основа клину паралельна площині XY поточної UCS (ПСК), а 

похила грань розташовується напроти першого вказаного кута 

основи. Висота клина (може бути як додатною, так і від’ємною) 

паралельна до осі Z. Ребро похилої грані орієнтоване вздовж осі 

Х. Для побудови клину потрібно задати координати двох 

протилежних вершин основи і висоту. Вибір опції Length (Длина) 

дозволить задати три розміри: Length – довжину вздовж осі Y, 

Width – ширину вздовж осі Х, Height – висоту вздовж осі Z. Опція 

CEnter призначена, щоб задати центр клину. Центром клину є 

центр похилої грані. 

Створення 3D-тіл з двовимірних об’єктів (ескізів). 3D-тіла 

можна створювати шляхом витиснення двовимірних об’єктів 

(тобто надання їм висоти) за допомогою команди EXTRUDE 

(ВЫДАВИТЬ). Витиснення можна застосовувати до замкнутих 

кривих: полілінії, многокутники, прямокутники, кола, еліпси, 

замкнуті сплайни, кільця і області. Неможливо витиснути 

тривимірні об’єкти, що входять в блоки, розімкнені полілінії і 

полілінії з сегментами, що перетинаються. Напрям витиснення 
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визначається траєкторією або заданням глибини і кута. Опція 

витискання знаходиться на вкладці «Моделирование»:  

Витискання (Extrude). Способи введення команди: 

- набрати з клавіатури команду: _extrude (ВЫДАВИТЬ); 

- викликати з меню: Draw > Modeling > Extrude (Рисование > 

Моделирование > Выдавить); 

- натиснути на кнопку  на панелі інструментів Solid > Solid 

> Extrude (Тело >Тело > Выдавить). 

Витискання здійснюється перпендикулярно до площини 

об’єкта або вздовж заздалегідь заданої траєкторії. Можна 

задавати кут конусності, під яким сторони тіла будуть 

звужуватись. Від’ємне значення кута призводить до розширення 

сторін. 

Об’єкт, що витискається може бути областю, колом, 

прямокутником кільцем, замкненою полілінією. Траєкторія 

вздовж якої витискається об’єкт, повинна належати одній 

площині і може бути відрізком, полілінією, дугою, але об’єкт і 

траєкторія не повинні належати одній площині. 

Команда Еxtrude (Выдавить) часто використовується для 

отримання моделей складних об’єктів такі, як шестерні або 

зірочки. Особливо зручна ця команда для об’єктів, що мають 

спряження, фаски і аналогічні елементи, які важко відтворити без 

використання витиснення перетинів. 

Обертання (Revolve). Способи введення команди: 

- набрати з клавіатури команду: _revolve (Вращать); 

- викликати з меню: Draw > Modeling > Revolve (Рисование > 

Моделирование > Вращать); 

- натиснути на кнопку  на панелі інструментів Solid > Solid 

> Revolve (Тело >Тело > Вращать). 

Тривимірний об’єкт утворюється з двовимірного обертанням 

навколо заданої осі. Двовимірний об’єкт може бути областю, 

колом, еліпсом багатокутником, замкненою полілінією або 

замкненим сплайном. Неможливо застосувати обертання до: 

тривимірних об’єктів; які входять в блоки; розімкнутих поліліній 

і поліліній з сегментами, що перетинаються. 



 

40  

Тіла можна створювати шляхом обертання замкнутих об’єктів 

на заданий кут довкола осі X або Y поточної UCS (ПСК). Крім 

того, об’єкт можна обертати довкола відрізка, полілінії або двох 

заданих точок. Подібно до команди EXTRUDE, цю команду 

зручно застосовувати для об’єктів, що мають спряження і інші 

аналогічні елементи. 

Вісь обертання вказується одним з методів: 

- Specify start point for axis of revolution (Начальная точка оси 

вращения) – задаються координати двох точок, початкової і 

кінцевої, що належать осі; 

- Опція Object (Объект) – вибирається відрізок або фрагмент 

полілінії; 

- Опція X/Y/Z: – віссю вибирається додатний напрям осі Х, Y 

або Z поточної системи координат. 

Варто зауважити, що для вісі повинна використовуватися 

штрих-пунктина лінія. Після визначення об’єкта обертання і осі 

вводиться довільне значення кута повороту об’єкта. 

Побудова складних 3D-тіл. AutoCAD дозволяє будувати 3D-

тіла складної форми, застосовуючи об’єднання, віднімання і 

перетин вже побудованих тіл. Елементи побудови складних тіл 

знаходяться на вкладці «Редактирование тела»: 

Об’єднання (Union). Способи введення команди: 

- набрати з клавіатури команду: _union (ОБЪЕДИНЕНИЕ); 

- викликати з меню: Modify > Solid editing > Union 

(Редактировать > Редактирование тела > Объединение); 

- натиснути кнопку  на панелі інструментів Solid > Boolean 

> Union (Тело > Логические операции > Объединение). 

За допомогою цієї команди можна побудувати складний 

об’єкт, що займає сумарний об’єм всіх його складових. 

Віднімання (Subtract). Способи введення команди: 

- набрати з клавіатури команду: _subtract (ВЫЧИТАНИЕ); 

- викликати з меню: Modify > Solid editing > Subtract 

(Редактировать > Редактирование тела > Вычитание); 

- натиснути кнопку  на панелі інструментів Solid > Boolean 

> Subtract (Тело > Логические операции > Вычитание). 
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За допомогою команди SUBTRACT можна видалити з тіл ті 

частини, які також належать іншій множині. Цю команду також 

можна застосувати для отримання отворів в механічних деталях 

шляхом віднімання циліндрів. 

Перетин (Intersect). Способи введення команди: 

- набрати з клавіатури команду: _intersect (ПЕРЕСЕЧЕНИЕ); 

- викликати з меню: Modify > Solid editing > Intersect 

(Редактировать > Редактирование тела > Пересечение); 

- натиснути кнопку  на панелі інструментів Solid > Boolean 

> Union (Тело > Логические операции > Пересечение). 

За допомогою команди INTERSECT можна побудувати 

складне тіло, що займає об'єм, загальний для двох або більш 

перетинних тіл. Неперетинні частини об'ємів при цьому 

видаляються з креслення. 

Редагування тривимірних тіл. В AutoCAD є різні засоби 

зміни форми об’ємних тіл та їх відображення. Техніка 

редагування твердотільних 3D-об’єктів передбачає зняття фасок, 

спряження, побудову перетинів і розділення на частини. Для 

редагування тривимірних об’єктів також можна застосовувати 

команди, які використовуються для редагування 2D-тіл. 

Елементи редагування тривимірних тіл знаходяться на вкладці 

«Редактирование», а також в меню «Тело > Редактирование 

тела»: 

Спряження граней 3D-тіл виконується за таким алгоритмом: 

1. Задати у командному рядку команду _fillet (Сопряжение), 

обрати з меню класичного AutoCAD пункт Modify > Fillet 

(Редактировать > Сопряжение) або натиснути в панельному 

меню Home > Modify (Тело > Редактирование тела) на кнопку 

. 

2. Вибрати ребро тіла для спряження. 

3. Задати радіус спряження. 

4. Продовжити вибір ребер або натиснути Еnter для переходу 

до побудови спряження. 

Зняття фасок у 3D-тілах виконується за таким алгоритмом: 

1. Задати у командному рядку команду _chamfer (Фаска), 

обрати з меню класичного AutoCAD пункт Modify > Chamfer 
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(Редактировать > Фаска) або натиснути в панельному меню 

Home > Modify (Главная > Редактирование) кнопку . 

2. Вибрати ребро базової грані для фаски. AutoCAD підсвічує 

одну або дві грані, суміжні з вибраним ребром. 

3. Для переходу до наступної грані ввести N (опція Next 

(Следующая)). Для підтвердження роботи з поточною виділеною 

гранню натиснути Еnter. 

4. Задати довжину фаски для базової грані. Довжина фаски 

для базової грані вимірюється від вибраного ребра до точки на 

базовій грані. 

5. Задати довжину фаски для суміжної грані. Довжина фаски 

для суміжної грані вимірюється від вибраного ребра до точки на 

суміжній грані. 

6. Вказати ребра, на яких необхідно зняти фаски. 

Розглянемо приклад побудови 3D-моделі у програмі AutoCAD. 

На початку побудови 3D-моделі необхідно створити новий файл 

креслення. Це можна зробити за допомогою вибору команди з 

меню File > New (Файл > Создать). У вкладці «Выбор шаблона» 

можна вибрати один зі шаблонів, у нашому випадку це може бути 

acadiso3d. У якості прикладу використано деталь з розмірами, які 

вказані на рис. 3.3. 

 

  
Рис. 3.3. Зовнійшні вигляд деталі з розмірами  

 

Для початку роботи з 3D-об’єктами необхідно у вкладці 

«Переключение рабочего пространства» (в правому нижньому 

кутку натиснути на кнопку ) встановити режим для роботи з 

тілами і поверхнями у трьохвимірному просторі «3D 

моделирование». На панельному меню у вкладці моделювання 
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вибираємо «Ящик» і відкладаємо довжину (160), ширину (90) і 

висоту нижньої частини деталі (15) (див. рис. 3.3), як зображено 

на рис. 3.4. Для перемикання введення розмірів (довжина, 

ширина, висота) застосовуємо клавішу Tab. 

 

 
Рис. 3.4. Результат побудови довжини, ширини і висоти основи 

деталі  

 

Далі будуємо верхній конус деталі. Для цього на панельному 

меню у вкладці «Моделирование» вибираємо «Конус». 

Переходимо на площину, шукаємо цент прямокутника і 

починаємо побудову вказавши у спливаючому меню радіус (45) 

і висоту конуса (75) (рис. 2.5). Для зручності встановлення 

центру прямокутника можна побудувати діагональні лінії 

перетин яких буде геометричним центром (після побудови лінії 

видаляються). Для точного позиціонування побудов 

використовуємо опцію «Привязка курсора к опорным точкам», 

яка знаходиться в Рядку стану. 
 

 
Рис. 3.5. Побудова верхнього конусу деталі 
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За розмірами приведеними на рис. 3.3 потрібно задати верхню 

частину конуса діаметром 70. Для цього необхідно потягнути за 

маркер (синя стрілка) на вершині конуса і задати потрібний 

радіус (рис. 3.6). 

 

 

 
Рис. 3.6. Встановлення розміру верхньої частини конуса 

 

У конусі маємо отвір діаметром 55 мм. Для його виконання 

потрібно накреслити ескіз кола. Для цього вибираємо «Круг» на 

вкладці «Рисование» панельного меню. Поставити цент круга у 

цент верхньої вершини конуса і задати відповідний розмір (рис. 

3.7). 

 

 
Рис. 3.7. Виконання отвору у верхній частині конуса 
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За допомогою команди «Выдавить» на вкладці 

«Моделирование», вказавши напрям до низу і висоту прорізу у 40 

мм, задаємо шлях прорізу у конусі (рис. 3.8). Після цього 

забираємо прорізаний циліндр із конуса. Для цього 

використовуємо команду «Вычитание» на вкладці панельного 

меню «Редактирование тела». Натискаємо на кнопку  на 

вкладці панельного меню та вказуємо фігуру з якої будемо 

проводити видалення (у нашому випадку це зрізаний конус) та 

натискаємо Enter, після цього вибираємо фігуру, яку потрібно 

вирізати (у нашому випадку це циліндр) та натискаємо Enter. У 

результаті маємо отримати деталь, як зображено на рис. 2.8. 

Також для візуального перегляду деталі можна змінити вид 

представлення на вкладці панельного меню «Вид», вибравши 

потрібний вид, як показано на рис. 3.9. 

 

 
Рис. 3.8. Встановлення напрямку та задання величини прорізу 

 

 
Рис. 3.9. Результат виконання команди «Вычитание» та виду  
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Наступним кроком є створення зрізів на нижній частині 

фігури. Для цього потрібно вказати межі зрізу, за допомогою 

команди «Отрезок» (15 мм) на вкладці «Рисование» панельного 

меню. А також прорізати отвори, діаметром 20 мм, за допомогою 

команди «Круг» на вкладці «Рисование» (рис. 3.10). Потім по 

утвореному контурі потрібно обрізати фігуру, за допомогою 

команди «Витягивание» на вкладці «Моделирование». 

 

  
Рис. 3.10. Процес утворення зрізів на нижній частині фігури 

 

Для виконання отвору внизу прямокутної основи, діаметром 

60 мм виконуємо ті ж самі дії, що і при побудові отвору у верхній 

частині конуса (див. рис. 3.7, 3.8). Вигляд виконаної фігури з 

отвором наведено на рис. 3.11. 

 

 
Рис. 3.11. Побудова отвору внизу прямокутної основи 

 

На завершення потрібно прорізати ще один отвір діаметром 

10 мм і висотою 15 мм. Для цього необхідно виконати дії, які 
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показано на рис. 3.7 та 3.8. У результаті виконання всіх побудов 

отримаємо 3D-модель, яка представлена на рис. 3.12. 

 

 
Рис. 3.12. Кінцевий вигляд виконання готової 3D-деталі 

 

Використовуючи ці та інші команди за подібним алгоритмом 

можна створювати 3D-деталі різної складності.   

 

Програма роботи 

1. Ознайомитися з принципами та правилами побудови 

тривимірних деталей у 3D просторі програми AutoCAD та 

розглянути приклад побудови 3D-моделі. 

2. За заданим варіантом виконати побудову 3D-моделі з 

відповідними розмірами.  

 

Порядок виконання роботи 

1. Розглянути можливості розробки 3D-об’єктів та приклад 

побудови 3D-моделі у програмі AutoCAD з теоретичних 

відомостей. 

2. Для закріплення навиків роботи з 3D тілами виконати 

побудову 3D-деталі за описаним у теоретичних відомостях 

прикладом (рис. 3.3). 

3. Вибрати 3D-модель згідно варіанту вказаного викладачем.  

4. Виконати побудову 3D-моделі за вказаними розмірами.  

5. Результати виконання креслення 3D-моделі оформити у 

вигляді звіту на стандартних аркушах формату А4. Креслення 

3D-моделі деталі виконати на окремому аркуші з рамкою та 

заповненим кутовим штампом. Додатково надати для перевірки 
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виконаний файл у форматі .dwg. 

 

Вимоги до оформлення звіту  

Звіт повинен містити: 

- титульний аркуш; 

- мету роботи; 

- програму роботи; 

- скріншоти виконання основних етапів побудови, які описані 

у порядку виконання роботи; 

- креслення розробленої 3D-деталі у аксонометричному 

вигляді на аркуші одного зі стандартних розмірів (А3-А1) з 

заповненим основним написом; 

- висновок. 

 

Контрольні запитання. 

1. Опишіть способи побудови 3D-об’єктів у програмі 

AutoCAD. 

2. Як відбувається побудова 3D-тіл у програмі AutoCAD? 

3. Як відбувається створення 3D-тіл з двовимірних об’єктів у 

програмі AutoCAD? 

4. Як відбувається створення складних 3D-тіл у програмі 

AutoCAD? 

5. Як відбувається редагування тривимірних тіл у програмі 

AutoCAD? 

6. Розкрийте особливість описаного прикладу створення 3D-

моделі у програмі AutoCAD. 
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Лабораторна робота 4 

Виконання проекцій, видів та розрізів 3D-моделей в 

програмі AutoCAD. 3D друк 

 

Мета роботи 

Навчитися виконувати проекції та розрізи 3D-моделей, а 

також формувати та подавати види для відображення готових 

креслень. Підготувати до 3D друку виконані у програмі AutoCAD 

3D-моделі. 

 

Теоретичні відомості 

Види та розміщення їх на кресленнях. Методи побудови і 

читання креслеників ґрунтуються на теоретичних засадах 

нарисної геометрії. Зображення предметів виконують за методом 

прямокутного проеціювання.  

При зображенні предмета чи його складової частини 

припускають, що він знаходиться між спостерігачем і 

відповідною площиною проекцій. Згідно вимог діючих 

стандартів кресленик повинен давати повну уяву про зовнішню 

та внутрішню форму предмета, його розміри та конструктивні 

особливості. Зображення на креслениках залежно від їх змісту 

поділяють на види, розрізи, перетини. Кількість видів, розрізів і 

перетинів повинна бути найменшою, але достатньою для повного 

уявлення про зображуваний предмет. 

Дві проекції визначають положення кожної точки в просторі. 

Деякі прості тіла обертання (валики, втулки і т. д.) можна 

зображувати в одній проекції, якщо на ній нанести розміри і 

позначення, що відображають їх форму Для зображення більш 

складних фігур необхідно три і більше проекцій . 

Видом називається зображення предмета зверненої до 

спостерігача видимої частини поверхні. На видах можна 

показувати і невидимі частини предмета за допомогою 

штрихових ліній. Шість основних видів стандартного 

розташування проекцій – це розгорнуті грані паралелепіпеда, у 

середині якого розміщують проекційований предмет (рис. 4.1). 

Найчастіше використовують три основних види: 

1. вид спереду, 
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2. вид зверху, 

3. вид зліва. 

При необхідності можна використовувати також додаткові 

види: 

4. вид справа, 

5. вид знизу, 

6. вид ззаду. 

 

 
Рис. 4.1. Види стандартного розташування проекцій 

 

Усі види зберігають на креслениках проекційний зв’язок, тому 

пояснювальних написів до видів не роблять. Якщо треба показати 

поверхню предмета, яка не паралельна ні одній з площин 

проекцій та потребує пояснень, використовують місцевий вид. На 

місцевому виді вказують стрілкою напрямок проекціювання та 

позначають його літерою, а в окремому вільному місці надають 

вказаний вид з тією ж літерою. 

Переріз (перетин) – це зображення, що утворюється при 

уявному розсіченні предмета площиною (або декількома 

площинами). Щоб одержати переріз, деталь розсікають уявною 

січною площиною в тому місці, де потрібно виявити її форму. На 

перерізі зображується тільки та плоска фігура, що знаходиться 

безпосередньо в січній площині (рис. 4.2). Все, що знаходиться 

поза січною площиною, не зображується. 

Місце розташування січної площини позначається 

потовщеною розімкнутою лінією з великими літерами і 



 

51  

стрілками, що показують напрямок погляду. Такими ж самими 

літерами позначають отриманий переріз (див. рис. 4.2). Для 

наочності зображення на кресленнях отриманий переріз 

виділяють штрихуванням. Залежно від розташування перерізи 

поділяються на накладені та винесені. 

 

 
Рис. 4.2. Приклади виконання перерізів 

 

Накладений переріз – зображення, яке пунктирною лінією без 

позначення літерами та стрілками, розташовують безпосередньо 

на виді кресленика в місці де проходила січна площина. Контур 

накладеного перерізу обводять суцільною тонкою лінією. Контур 

перерізу не переривають в місцях, де переріз закриває контурні 

лінії виду. Вісь симетрії накладеного перерізу вказують штрих-

пунктирною лінією без позначення літерами та стрілками. 

Винесений переріз – зображення, яке розташовують поза 

контурами наданого тіла. Товщина ліній контуру такого перерізу 

виконується суцільною основною лінією такої ж товщини, як і 

для всього кресленика. Винесений переріз можна помістити на 

будь-якому місці поля кресленика. Воно може бути розташовано 

безпосередньо на продовженні лінії перерізу. Переріз повинен 

своєю побудовою і розташуванням відповідати напрямку, 

відзначеному стрілками. На перерізах рекомендується наносити 

необхідні розміри (див. рис. 4.2). Переріз звичайно виконують в 
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тому ж самому масштабі, що і вид, до якого його роблять. 

Якщо на одній деталі роблять декілька однакових перерізів, то 

їх позначають однією тією ж літерою і викреслюють лише один 

переріз (рис. 4.3). 

Рис. 4.3. Приклади виконання однакових перерізів 

 

Розрізом називається зображення предмета, уявно розсіченого 

однією або декількома площинами. На розрізі показують те, що 

знаходиться в січній площині, і те, що розташовано за нею. 

Ближчу відсічену частину уявно відкидають. Розрізи бувають 

прості, складні та місцеві. 

Простий розріз – це розріз, який зроблено за допомогою однієї 

січної площини (рис. 4.4). Залежно від положення січної 

площини розрізи поділяються на вертикальні і горизонтальні. 

Рис. 4.4. Приклад простого вертикального профільного розрізу 

 

Якщо січна площина паралельна фронтальній площині 

проекцій, вертикальний розріз називають фронтальним. Коли 

січна площина паралельна профільній площині проекцій, 
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вертикальний розріз називають профільним. У випадку, коли 

січна площина горизонтальна, розріз називають горизонтальним. 

На одному кресленику може бути декілька розрізів, але 

кожний з них повинен бути доцільним. Розрізи звичайно 

розташовують у проекційному зв’язку: фронтальний – на місці 

головного виду, профільний – на місці виду зліва, а 

горизонтальний - на місці виду зверху. Розрізи позначають так 

само, як перетини, розімкнутою лінією. Стрілки з літерами 

показують напрямок погляду. Над розрізом пишуть ті ж самі 

літери через тире. 

Місцевим називають розріз, який служить для з'ясування 

форми предмета, в окремому місці деталі, наприклад, отвору. 

Коли робити повний розріз недоцільно місце розрізу виділяють 

на зображені суцільною тонкою хвилястою лінією. Суцільні тіла 

розрізати не слід, у тому числі й напливи на деталі. 

Складним вважається розріз, який має дві й більше січні 

площини. Якщо ці площини паралельні, то розріз називається 

східчастим. Розріз виконується так, начебто зроблений однією 

площиною без будь яких ліній у місці сходинки (штрихування на 

фронтальній проекції без переходів). Січні площини позначені 

потовщеною розімкнутою лінією перетину з літерами і стрілками 

з потовщеними штрихами в місцях перегинів де показують кінець 

однієї і початок іншої січної площини (літери у перегинах не 

ставлять). Складний розріз обов’язково позначається 

українськими великими літерами. 

Штрихування. Лінії штрихування можна проводити з 

нахилом ліворуч або праворуч, але для всіх розрізів і перерізів, 

що належать одній і тій самій деталі, штрихування треба зазвичай 

виконувати з нахилом в один бік. Відстань між прямими лініями 

штрихування має бути однакова для всіх розрізів і перерізів 

деталі, що виконуються в одному масштабі. Залежно від 

матеріалу, що зображується, площі штрихування та необхідності 

урізноманітнити штрихування суміжних площин, відстань між 

лініями штрихування вибирають у межах 1 – 10 мм. 

Похилі паралельні прямі у штрихуванні проводять під кутом 

45° до лінії контуру зображення (рис. 4.5, а) або до його осі (рис. 

4.5, б), чи до лінії рамки кресленика (рис. 4.5, в). Якщо лінії 
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штрихування збігаються з лініями контуру чи осьовими лініями, 

рекомендується лінії штрихування проводити під кутом 30° або 

60°. 

 
а             б                                  в в 

Рис. 4.5. Приклади нанесення штрихування 

 

Перерізи, ширина яких на зображенні становить менше ніж 

2 мм, допускається зачорнювати, але залишати просвіт між 

суміжними перерізами не менше ніж 0,8 мм. Для суміжних 

перерізів двох деталей слід виконувати зустрічне штрихування: 

на одній деталі праворуч, на іншій – ліворуч. Для суміжних 

перерізів трьох і більше деталей треба, щоб лінії штрихування 

одного напряму були зсунуті в одному перерізі відносно іншого 

(рис. 4.6, а), або слід змінити відстань між лініями штрихування 

(рис. 4.6, б). 

                                     
                                    а                                     б 

Рис. 4.6. Штрихування суміжних перерізів. 

 

Виконання штрихування у програмі AutoCAD. Для 

умовного графічного зображення матеріалів у розрізах і 

перерізах в AutoCAD застосовують різноманітні штрихування. В 

архітектурних кресленнях штрихування застосовують для 

позначення матеріалу покриття. У технічних кресленнях 

штрихування застосовують для позначення типу 

конструкційного матеріалу. 
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Штрихування вставляється, як єдиний об’єкт так і для того 

щоб його видалити, для цього достатньо виділити одну лінію. 

Штрихування виконується для замкнутих областей. У програмі 

AutoCAD передбачено декілька типів штрихувань, які 

створюється на основі узорів з ліній, які повторюються, на основі 

вбудованої бібліотеки стандартних зразків штрихування. 

В програмі AutoCAD штрихування характеризуються двома 

властивостями: 

1) штрихування є блоками – всі лінії, які знаходяться 

всередині позначеної області, є частиною єдиного об’єкта; 

2) штрихування є асоціативними – при зміні розміру об’єкта 

використане в ньому штрихування автоматично оновиться і 

прийме нову форму. 

Способи використання команди штрихування: 

- Набрати з клавіатури команду: _bhatch (КШТРИХ); 

- Виклик з меню: Home > Draw > Hatch (Рисование > 

Штриховка); 

- Кнопка на панелі Home > Draw > Hatch (Рисование > 

Штриховка): . 

Команда _bhatch (КШТРИХ) відкриває на панелі меню 

вкладку Hatch Creation (Создание штриховки) з вкладками 

Boundaries (Контуры), Pattern (Образец), Properties (Свойства), 

Origin (Начало), Options (Параметры), Close (Закрыть) (рис. 

4.7).  

 

 
Рис. 4.7. Вкладка Hatch Creation (Создание штриховки) на 

панельному підменю 

 

На вкладці Pattern (Образец) вибирається штриховка за 

іменем зі списку або за малюнком – зразки малюнків 

представлені у вікні. У Properties (Свойства) можна задати кут 

нахилу і масштаб штрихування. Після вибору зразка штриховки і 

параметрів штрихування необхідно показати об’єкти, які будуть 

заштриховані. 
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Для вибору об’єктів штрихування пропонується декілька 

способів. Можна вибирати безпосередньо об’єкт або вказувати 

точку всередині замкнутого контуру, надаючи можливість 

системі автоматично визначити область, яка підлягає 

штрихуванню – вкладка Boundaries (Контуры). Для виконання 

вибору натискується відповідна кнопка, яка повертає 

користувача у вікно креслення, почергово вибирається кожен 

об’єкт або вказуються точки всередині замкнутих контурів. Після 

здійснення вибору повернутися в діалогове вікно штрихування 

можна, натиснувши клавішу Enter. 

На вкладці Options (Параметры) (рис. 4.8) є можливість 

вибору асоціативної або аннотативної штриховки. 

Асоціативність означає, що штриховка прив’язується до контурів 

об’єкта та при зміні їх форми автоматично змінюється і область, 

яка заповнена штриховкою. Аннотативність передбачає 

автоматичне масштабування штриховки разом із об’єктом при 

масштабуванні. А команда _hatch (ШТРИХ) створює 

неасоціативне штрихування. Функцію асоціативності можна 

увімкнути/вимкнути на вкладці Options (Параметры). 

Застосування стилю штрихування Ассоциативный (Associative) 

забезпечує створення асоціативної штриховки, тобто такої, що 

відслідковує всі модифікації контуру. Якщо не вибрано 

відповідний параметр штрихування, то в AutoCAD створюється 

неасоціативна штриховка, яка не змінюються при модифікації 

контуру. 

 

 
Рис. 4.8. Вибір типу виконання штрихування 

 

Виконання розрізів у програмі AutoCAD. Для того, щоб 

розмістити розроблену 3D-модель на стандартних аркушах 

відповідного формату, для подальшого їх друку необхідно 

виконати розташування моделі у відповідності до видового 

представлення (див. рис. 4.1). Виконання цієї операції 
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здійснюється за допомогою інструменту який знаходиться на 

вкладці Вид > Базовый > Из пространства модели (рис. 4.9). 

Після його вибору вказуємо (клацаємо ЛКМ) нашу 3D-модель та 

двічі натискаємо Enter, після чого AutoCAD переключиться з 

вкладки «Модель» на вкладку «Лист1», що знаходяться в лівій 

нижній частині екрану.  

 

 
Рис. 4.9. Стврення видового представлення моделі 

 

Тепер можемо розташовувати модель на аркуші креслення 

відповідного формату (починаючи з головного виду). Для цього, 

наводимо на необхідне місце, як правило це верхня ліва частина 

аркуша та натискаємо ЛКМ і Enter. Таким чином ми розташували 

головний вид. Відштовхуючись від головного виду створюємо 

всі інші види, переводячи курсор миші в сторони від основного 

виду. Для підтвердження вибору виду натискаємо ЛКМ. По 

завершенню розміщення всіх необхідних видів натискаємо Enter. 

У результаті побудови отримаємо розташування 3D-моделі 

подібно, як це показано на рис. 4.10. 

 

 
Рис. 4.10. Розташування 3D-моделі в залежності від виду 
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Зауваження. Для відображення на аркуші розташування 

моделі відповідного формату та рамки з кутовим штампом 

потрібно виконати попереднє налаштування параметрів лімітів 

креслення Параметры листа в діалоговому вікні, так як це 

виконувалося лабораторній роботі 1 та відображено на рис. 1.12 

(див. теоретичні відомості до лабораторної роботи 1). 

Для додавання розрізів та перерізів потрібно перейти у 

вкладку «Лист», яка доступна при видовому розташуванні 

моделі відповідного аркушу (рис. 4.11). 

 

 
Рис. 4.11. Зовнішній вигляд меню Лист 

 

Для виконання розрізу натискаємо на кнопку Сечение, що на 

панелі Лист вибираємо необхідний тип розрізу та вказуємо на 

виді зверху 3D моделі лінію розрізу, після чого розміщуємо вид 

3D-моделі з вказаним розрізом у відповідному місці (рис. 4.12).  

 

 
Рис. 4.12. Способи виконання розрізів 
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Для того щоб виконати кутовий, або інший розріз неохідно 

виконати той самий алгоритм дій, але замість «Полный» вибрати 

«Смещение» тоді можна на головному виді моделі провести 

декілька ліній за якими буде здійснено розріз. А для додавання 

додаткових видів розрізів необхідно вибрати інструмент 

Проекцинный. 

Для того, щоб виконати, або відредагувати штрихування 

розрізів. Двічі клаціємо на відповідній штриховці ЛКМ, після 

цього програма переключиться на панель Редактор штриховки 

вида чертежа (рис. 4.13), що дасть змогу виконати всі необхідні 

зміни штрихування (якщо потрібно). 

 

 
Рис. 4.13. Процес редагування штрихування на розрізі моделі 

 

3D друк розроблених 3D моделей. Для виконання 3D друку 3D 

моделі виконаної у програмі AutoCAD необхідно зберегти її у 

одному з форматів: ffp, stl, obj. Наприклад, виконуємо 

перетворення 3D-моделі у формат *.stl за допомогою функції 

експорт за послідовністю: Экспорт > Другие форматы. В меню 

Экспорт даных вибираємо Тип файла: Литография (*.stl). 

Надаємо файлу ім’я та зберігаємо у вказану папку. Після цього, 

відкриваємо 3D-модель у одному з програмних середовищ для 3D 

друку, наприклад FlashPrint (Файл > Загрузити файл) (рис. 4.14). 
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Рис. 4.14. Виконання завантаження 3D-моделі у програму 

FlashPrint 

 

Внаслідок виконаних вищеописаних дій, завантажена 3D-

модель з’явиться в робочому просторі програми FlashPrint (рис. 

4.15). 

 

 
Рис. 4.15. Вигляд робочого середовища програми FlashPrint 

з завантаженою 3D-моделлю 

 

Деколи буває, що модель виконано некоректно, наприклад 

полігони моделі накладаються одні на одних, або в одному місці 

простору перебуває більше ніж одна точка, тому при відкритті 

такої 3D-моделі програма FlashPrint попередить про помилку 
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обробки об’єкта (рис. 4.16). При виникненні такої ситуації 

необхідно виконати наступні дії: Восстановить модель, або 

Пропустить. При виконанні дії Восстановить модель – всі 

полігони, що накладалися будуть автоматично відокремлені від 

об’єкта і знаходитимуться поза ним, як окремі об’єкти. Деколи в 

результаті винесення в окремі об’єкти зовнішніх полігонів 

модель перестає бути придатною для 3D друку. 

 

 
Рис. 4.16. Попередження програми FlashPrint про помилку при 

заванатженні 3D-моделі 

 

При виконанні функції Пропустить модель можна 

використати для 3D друку, але при спробі її масштабування в 

програмному середовищі, вона може втратити початкову форму 

(полігони, що накладалися будуть масштабуватися окремо в 

результаті чого почнуть заходити за межі об’єкта). Найкращим 

варіантом вирішення цієї ситуації буде завчасно виконати 

масштабування моделі в програмі її створення (у нашому 

випадку це AutoCAD) і після цього знову завантажувати у 

FlashPrint.  

Після вирішення помилок (якщо вони були), попередньо 

переглядаємо 3D-модель та переходимо до 3D-друку натиснувши 

на кнопку Начать нарезку. При цьому, відкриється вікно 

налаштування: Нарезать (рис. 4.17). 

 

 
Рис. 4.17. Вигляд вікна налаштування 3D друку 
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Меню Нарезать дає змогу виконати всі необхідні 

налаштування у випадку, якщо розроблена 3D-модель не має 

навісних елементів, площа контакту об’єкта з робочою 

поверхнею 3D-принтера суцільна. Якщо ці умови дотримані (див. 

рис. 4.17), тоді достатньо вибрати: тип пластику для правого 

екструдера (1) (за замовчуванням PLA) і швидкість друку (2). 

Після цього, виконуємо команду «Нарезать» (3) і вікно 

налаштування закриється та знову відкривається робочий простір 

програми, а поряд з кнопкою «Начать нарезку» (рис. 4.18) 

з’являться кнопки «Предварительный просмотр фрагмента» (1) 

і кнопка завантажити (2). 

 

 
Рис. 4.18. Зовнішній вигляд верхньої частини робочого простору 

програми FlashPrint 

 

Крім того, у вікні попереднього перегляду можна переглянути 

кожен шар майбутнього об’єкта, для цього використовують два 

повзунки, що знаходяться у нижній частині робочого простору 

програми, які показані на рис. 4.19. 

 

 
Рис. 4.19. Меню для пошарового перегляду друкованого об’єкта 
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Після остаточної перевірки 3D-моделі та оцінки пошарового 

нарізання можна завантажити готовий файл моделі на карту 

пам’яті та вставити її в 3D-принтера. Далі в меню «Print» 

натискаємо кнопку ОК та починаємо друк. Якщо при 

завантаженні файлу випливає повідомлення: «sd card don’t read» 

процедуру потрібно виконати ще раз, оскільки деколи 3D-

принтер з першого разу не може прочитати інформацію з карти 

пам’яті.  

 

Програма роботи 

1. Ознайомитися з принципами та правилами побудови 

проекцій та розрізів 3D-моделей, а також навчитися формувати 

та подавати види для відображення готових креслень у програмі 

AutoCAD. 

2. Виконати підготовку розробленої 3D-моделі до 3D друку 

за допомогою програми FlashPrint та виконати друк моделі.  

   

Порядок виконання роботи 

1. Розглянути можливості розробки розрізів, перерізів та 

штрихувань 3D-об’єктів у програмі AutoCAD, а також 

послідовність підготовки 3D-моделі до 3D друку з теоретичних 

відомостей. 

2. Виконати попередні налаштування параметрів листа з меню 

Параметры листа, так як це описано у лабораторній роботі 1.  

3. Вибрати розроблену в лабораторній роботі 1 рамку з 

заповненим кутовим штампом та відкрити її для подальшого 

використання з 3D-моделлю. Якщо розроблена у лабораторній 

роботі 3 3D-модель не підходить за розмірами під розміри рамки, 

які студент виконував у лабораторній роботі 1, то необхідно 

вибрати одну зі стандартних рамок наявних у шаблонах 

AutoCAD, завантажити її та заповніть кутовий штамп. Для цього 

перейдіть за посиланням: Файл > Создать > Создание нового 

чертежа > Чертеж та виберіть один з варіантів оформлення. 

4. Відкрити 3D-модель виконану згідно варіанту з 

лабораторної роботи 3.  

5. Виконати видове представлення моделі, так як це описано 

в теоретичних відомостях. Розташуйте розроблену у 
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лабораторній роботі 3 3D-модель за трьома основними видами 

так, як це показано на рис. 4.1. 

6. Виконайте повний (Полный) та кутовий (Смещение) розріз 

3D-моделі так, як це показано в  теоретичних відомостей. 

6. Виконайте редагування штрихування виконаних розрізів 

змінивши їх на інший, який потрібно вибрати з меню Образец, 

що на панелі Редактор штриховки вида чертежа (рис. 4.13) за 

варіантом: 1-5 – ANSI31; 6-10 – ANSI32; 11-15 – ANSI33; 16-20 – 

ANSI33; 21-25 – ANSI34; 26-30 – ANSI35.  

7. Виконати підготовку розробленої у лабораторній роботі 3 

3D-моделі до 3D-друку у програмі FlashPrint за послідовністю, 

яка описана в теоретичних відомостях. 

Зауваження. Програма FlashPrint є безкоштовною. Її можна 

завантажити зі сторінки дисципліни на навчальній платформі 

Moodle та встановити (інсталювати) на комп’ютер.  

8. Завантажити готовий файл моделі на карту пам’яті та 

виконати друк на 3D-принтері. 

9. Результати виконання оформити у вигляді звіту на 

стандартних аркушах формату А4. Креслення 3D-моделі з 

перерізами виконати на окремому аркуші з рамкою та 

заповненим кутовим штампом. Додатково надати для перевірки 

файли у форматі .dwg та .stl 

 

Вимоги до оформлення звіту  

Звіт повинен містити: 

- титульний аркуш; 

- мету роботи; 

- програму роботи; 

- скріншоти виконання основних етапів виконання, які 

описані у порядку виконання роботи; 

- креслення розробленої 3D-деталі на аркуші одного зі 

стандартних розмірів (А3-А1), виконаними розрізами та 

штрихуванням у відповідності з варіантом. Кутовий штамп має 

бути заповненим; 

- виконаний файл у форматі dwg; 

- підготовлений файл моделі у програмі FlashPrint для 

виконання 3D друку та завантаження у 3D принтер;  
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- висновок. 

 

Контрольні запитання. 

1. Що таке розріз. 

2. Що таке переріз. 

3. Що таке штрихування. 

4. Як виконується розрізи та перерізи у програмі AutoCAD? 

5. Як виконується штрихування у програмі AutoCAD? 

6. Яким чином виконується підготовка та друкування 3D 

моделі на 3D принтері? 
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Лабораторна робота 5 

Розробка електричних схем у програмі AutoCAD Electrical  

 

Мета роботи 

Ознайомитися з основними правилами креслення 

електричних схем та навчитися використовувати операції 

програми AutoCAD Electrical для розробки простих електричних 

схем  

 

Теоретичні відомості 

Схема є конструкторським документом, на якому показано у 

вигляді умовних зображень або позначень складові частини 

виробу (установки) і зв'язки між ними. Загальні правила 

виконання схем визначаються ГОСТ 2.701 і ГОСТ 2.702. Схемна 

документація є основною частиною комплекту конструкторської 

документації і призначена для виробництва, експлуатації, 

модернізації і ремонту устаткування. 

Принципова електрична схема (ПЕС) – це схема, яка визначає 

повний склад елементів і зв’язків між ними і надає детальне 

уявлення про принципи роботи виробу (пристрою). Види і типи 

схем, загальні вимоги до їх виконання, УГП (умовно-графічне 

позначення) елементів в схемах регламентуються державними 

стандартами та Єдиною системою конструкторської документації 

(ЄСКД). Принципові електричні схеми виконують у 

відповідності до ГОСТ 2.701 (2008), ГОСТ 2.702 (1977), ГОСТ 

2.721-74, ГОСТ 2.756-76 та ін., на окремі пристрої, установки або 

її частини. 

Умовні графічні позначення елементів ПЕС регламентуються 

державними стандартами, які містять, як загальні позначення так 

і позначення для різних типів та видів обладнання. Зарубіжні 

стандарти на УГП, зокрема, американські ANSI і IEEE значно 

відрізняються від позначень за ЄСКД. Тому для розробки 

електричних схем за зарубіжними стандартами необхідно 

користуватися спеціальною довідковою літературою. 

Одним з широковживаних програмних продуктів, що 

використовується для проектування електричних схем є програма 

- AutoCAD Electrical. AutoCAD Electrical - це програма яка має 
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спеціалізовані електротехнічні та схемотехнічні можливості, що 

використовується для створення різноманітних схем: 

електричних систем управління, монтажних схем, схем 

підключення, схем автоматизації та ін. AutoCAD Electrical 

використовують для розробки креслень пристроїв і елементів та 

безпосереднього креслення електричних схем.  

AutoCAD Electrical містить повний набір функцій AutoCAD до 

яких додані спеціалізовані інструменти, які автоматизують 

процеси створення схем, креслень, компоновок, генерування 

звітів та специфікацій та ін. Проект створений AutoCAD Electrical 

має деревоподібну структуру, що відображається в диспетчері 

проектів. Інформація про кожен аркуш проекту може включати 

до десяти параметрів. Крім цього в диспетчері проектів можна 

попередньо переглянути аркуш проекту або інформацію про 

кожен файл проекту. Всі дії з проектом, зокрема відкриття, 

закриття, створення нового проекту, друк і багато іншого 

виконуються з диспетчера проектів. 

Використання AutoCAD Electrical при розробці схем дає змогу 

значно скоротити час і зусилля на розробку завдяки застосуванню 

таких засобів: 

1) автоматизація рутинних процесів: автоматичне маркування 

ліній зв’язку, позиційних позначень, контактів, тощо; 

2) бібліотеки умовних графічних позначень (УГП); 

3) бази даних у форматі MS Aссess з можливістю їх 

поповнення; 

4) багаторазове використання ділянок схем в різних проектах, 

як за допомогою інструментів копіювання, так і за допомогою 

збереження цих ділянок в меню УГП, що доступне для будь якого 

проекту; 

5) швидке внесення змін в процесі розробки, тобто при 

внесенні змін в будь-яку частину проекту вони автоматично 

відображаються у всіх його складових; 

6) автоматичний і автоматизований контроль помилок; 

7) зручні інструменти роботи з клемниками, що дає змогу 

набирати їх з окремих клем і дозволяє використовувати в схемах 

з будь-якою кількістю клем; 
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8) зручні інструменти роботи з програмованими логічними 

контролерами (ПЛК); 

9) автоматизоване генерування текстових документів, що 

входять у склад конструкторської документації. 

Інтерфейс AutoCAD Electrical має всі можливості та подібний 

до інтерфейсу звичайного AutoCAD (рис. 5.1), але на відміну від 

нього має додатковий комплекс інструментів спеціального 

призначення. При виборі панелі меню Главная в AutoCAD 

Electrical відображається вміст всіх інструментів класичного 

AutoCAD: Рисование, Редактирование, Аннотации та ін.  

 

 
Рис. 5.1. Інтерфейс програми AutoCAD Electrical при виборі 

панелі меню Главная 

 

AutoCAD Electrical має тіж самі робочі простори, що і 

класичний AutoCAD, але з функціями креслення схем (рис. 5.2): 

- ACADЕ, 2D рисування і анотації; 

- ACADЕ, 3D моделювання; 

- 2D рисування і анотації; 

- 3D моделювання. 

 

 
Рис. 5.2. Вибір робочих просторів на вкладці «Переключение 

рабочего пространства» у програмі AutoCAD Electrical 
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Важливою складовою програми AutoCAD Electrical є 

можливість роботи над проектом/ми. Для цього 

використовується вкладка «Проект» (рис. 5.3), яка надає всі 

можливості для організації документів цілого проекту. У функції 

«Диспетчер проектов», використовуються опції для 

заощадження часу та підвищення продуктивності під час роботи 

над проектом. Це дозволяє створювати проекти, редагувати, 

повторно позначати компоненти, вносити зміни до файлу з 

документами проекту та отримувати доступ до опцій експорту з 

інших проектів. 

 

 
Рис. 5.3. Інтерфейс AutoCAD Electrical при виборі панелі 

«Проект» 
 

Основним робочим простором при проектуванні принципових 

електричних схем у програмі AutoCAD Electrical є середовище з 

відповідним набором інструментів, яке активізується при виборі 

панелі «Схема». Зовнішній вигляд інтерфейсу AutoCAD Electrical 

2022 в режимі розробки схем показано на рис. 5.4. 

Основним елементом будь якої програми для розробки схем є 

наявність бібліотеки умовних графічних позначень (УГП). У 

програмі AutoCAD Electrical наявні всі необхідні бібліотеки УГП, 

які застосовуються для розробки схем згідно з Держстандартами 

України та міжнародними стандартами. Доступ до необхідного 

позначення здійснюється за допомогою опції «Графическое 

меню», яке знаходиться на панелі «Вставить компонент» на 

вкладці «Схема» (рис. 5.4). 
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Рис. 5.4. Інтерфейс AutoCAD Electrical 2022  

в режимі розробки схем при виборі панелі Схема 

 

Для того, щоб вставити електричний елемент на принципову 

електричну схему можна використати «Обозреватель 

каталогов» на панелі «Вставить компонент». Після відкриття 

«Обозреватель каталогов» з вкладки «Категория» вибрати 

необхідну категорію, наприклад «Конденсаторы», потім вказати 

виробника, конкретну марку чи модель та вибрати її з каталогу 

доступних виробників, як це показано на рис. 5.5. Якщо 

необхідного компонента немає, то його можна віднайти 

застосувавши кнопку «Глобальный поиск», або вибрати інший, 

аналогічний, який є в наявному каталозі (рис. 5.6). 
 

 
Рис. 5.5. Зовнішній вигляд меню «Вставить компонент» при 

додаванні компонентів електричних схем з каталогу виробників 
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Рис. 5.6. Процес виконання глобального пошуку з каталогів 

виробників 

 

Якщо при виборі у каталозі необхідний графічний образ не 

відображається, або при виконанні принципової електричної 

схеми не потрібно відразу прив’язуватися до конкретного 

виробника обладнання, то електричний компонент можна 

віднайти за допомогою графічного меню «Вставить 

компонент», що автоматично відкриється, або його можна 

відкрити з головного меню «Схема». Зовнішній вигляд  меню для 

пошуку та вставлення компоненту показано на рис. 5.7. За 

допомогою цього меню можна віднайти необхідний компонент, 

або його аналог. 

Після виконання вибору відповідного елементу та виконання 

команди «Вставка образа, выбраного в графическом меню» 

відкриється вікно «Вставить / Редактировать компонент» (рис. 

5.8). При цьому, вказуються автоматичні дані компонента з 

вибраного каталогу, а також можна ввести у відповідне меню 

необхідні дані, наприклад виводи, номінальні значення, 

позиційні позначення та інші. Варто зауважити, що вказані в 

даному меню опції будуть зв’язувати компонент з відповідним 

його відображенням на монтажній схемі, а також вони можуть 

використовуватися при автоматичному формуванні звітів та 

специфікацій.   
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Рис. 5.7. Зовнішній вигляд меню для пошуку та вставлення 

компоненту 

 

 
Рис. 5.8. Вигляд вікна «Вставить / Редактировать компонент» 

 

Якщо у вибраному по замовчуванню меню «Вставить 

компонент» немає необхідного компонента, то його можна 

віднайти у іншій базі графічних образів, яку можна відкрити на 

вкладці: «Другие > Мастер графического меню». На панелі 

«Выбор файла меню» натиснути кнопку «Обзор» та додати 

необхідну бібліотеку, вибравши її та натиснувши кнопку 
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«Відкрити», а потім кнопку «ОК». Розміщені бібліотеки 

графічних образів, як правило мають розширення *.DAT, 

наприклад ACE_IEEE_MENU.DAT. 

Якщо необхідного компонента не вдалося віднайти у базах 

графічних образів, то його можна накреслити самостійно за 

допомогою примітивів класичного AutoCAD: коло, лінія, 

полілінія та інші, що знаходяться на вкладці меню «Главная». 

Створений компонент можна додати до користувацької 

бібліотеки використавши вкладку «Другие > Конструктор 

графического образа». Після цього у меню «Выбор 

образа/объекта» (рис. 5.9) потрібно вказати вибраний компонент 

надати йому ім’я, вказати папку для його збереження та ввести 

необхідні атрибути (рис. 5.10).  

 

 
Рис. 5.9. Вибір та формування графічного образу нового 

компонента 
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Рис. 5.10. Внесення даних про новий компонент 

 

Після введення попередніх даних програма AutoCAD 

Electrical перейде в режим додавання всієї необхідної інформації 

про новий компонент (рис. 5.11): атрибутів, точки прив’язки 

виводів та інших, що в кінцевому результаті призведено до 

створення повноцінного компонента зі всіма необхідними 

параметрами подібно, як це показано на рис. 5.8. Після виконання 

всіх дій завершуємо редагування нового компонента натиснувши 

на кнопку «Закрыть редактор блоков». 

 

 
Рис. 5.11. Вигляд меню формування даних про новий компонент 
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Після того, як вибрані необхідні електричні компоненти, та 

вставлені на місце в робочому просторі програми, потрібно 

вставити електричні з’єднання (провідники). Це можна зробити 

використавши вкладку «Провод», яка знаходить на панелі 

«Вставить провода/номера проводов». В процесі розстановки 

провідників AutoCAD Electrical автоматично прив’язує кінці 

проводів та виконує їх маркування до вибраних (вставлених) 

електричних елементів (рис. 5.12).  
 

 
Рис. 5.12. Процес автоматичного вставлення електричного 

провода та його прив’язка до відповідних контактів 
 

На будь якому етапі виконання схеми у AutoCAD Electrical 

передбачена можливість редагування вибраних елементів та 

провідників. Для цього використовується відслідковуване 

(контекстне) меню компонента (рис. 5.13, а) та відслідковуване 

(контекстне) меню провідника (рис. 5.13, б). Відслідковуване 

меню являє собою радіальне контекстне меню, яке викликається 

наведенням курсора на об’єкт електричної схеми і клацанням на 

ньому ПКМ. Доступні параметри в меню залежать від типу 

об’єкта, на який наведено курсор.   
 

   
       а)                                                б) 

Рис. 5.13.  Зовнішній вигляд відслідковуваного (контекстного)  

меню компонента (а) і провідника (б) 
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Для полегшення розуміння принципових електричних схем на 

кресленнях схем можуть приводитися пояснюючі написи. До них 

відносяться: короткі пояснення принципу дії і послідовності 

включень елементів схеми, відомості режимів роботи, часові та 

інші характеристики схем, пояснення дії захисту і сигналізації. Ці 

короткі пояснення приводяться в описах роботи елементів схеми 

з посиланням на УГП. Вставлення пояснюючих написів 

відбувається за допомогою панелі «Аннотация» в меню 

«Главная». Детально про це розглядалося у лабораторній роботі 

1. Текстові пояснення можуть виглядати так: «При натисканні 

кнопки спрацьовує реле К1, що своїм контактом К1.1 включає 

соленоїдний клапан...» і т.д. 

 

Програма роботи  

1. Розглянути основні правила розробки принципових 

електричних схем та особливість використання програми 

AutoCAD Electrical.  

2. Використовуючи базу умовних графічних позначень 

навчитися розробляти прості принципові електричні схеми. 

 

Порядок виконання роботи 

1. Розглянути правила розробки принципових електричних 

схем та особливість використання програми AutoCAD Electrical, 

що описаний у теоретичних відомостях. 

2. Створити новий проект у програмі AutoCAD Electrical. Для 

цього запустіть програму та виберіть Создать > Выбор шаблона 

ACAD_ELECTRICAL_IEC.dwt або ACAD_ELECTRICAL.dwt. 

3. Вибрати варіант принципової електричної схеми за 

вказівкою викладача згідно з порядкового номера студента у 

списку групи. 

4. Відкрити проект на панелі меню «Схема» у вкладці 

Вставить компонент виберіть «Обозреватель каталогов» або 

«Графическое меню та з каталогу виробників виберіть необхідні 

компоненти, що відповідають варіанту схеми та вставте їх у 

певних місцях на робочому полі схеми приблизно так, як 

зображено у варіанті завдання. При відсутності моделі 

конкретного електричного компоненту вказаного у завданні 
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можна вибрати аналог з графічного меню «Вставить 

компонент», або накреслити його самостійно за допомогою 

примітивів AutoCAD так, як описано у теоретичних відомостях 

(див. рис. 5.9-5.11). 

Зауваження. У варіанті завдання схеми замість реальних 

електричних компонентів показаний прямокутник та вказано 

його параметр і номінал, наприклад конденсатор, резистор, 

тиристор та ін. При розробці принципової електричної схеми 

необхідно замість цього прямокутника віднайти відповідне УГП 

та вставити (використати) його у відповідному місці схеми.  

5. Виконати з’єднання вибраних та встановлених на робоче 

поле елементів провідниками з меню «Вставить провода/номер 

проводов > Провод». 

6. Виконайте остаточне оформлення схеми, додайте перелік 

використаних елементів у текстовому вигляді на полі схеми 

використовуючи вкладку «Аннотации». 

7. Результати виконання креслення схеми оформити у вигляді 

звіту на стандартних аркушах формату А4 з рамкою та 

заповненим кутовим штампом та надати виконаний файл у 

форматі .dwg. 

 

Вимоги до оформлення звіту  

Звіт повинен містити: 

- титульний аркуш; 

- мету роботи; 

- програму роботи; 

- скріншоти виконання основних етапів побудови, які описані 

у порядку виконання роботи; 

- креслення виконання схеми на окремому аркуші з рамкою та 

заповненим основним написом; 

- висновок. 

 

Контрольні запитання 

1. У чому суть розробки схем? 

2. Яка особливість програми AutoCAD Electrical? 

3. Які переваги використання програми AutoCAD Electrical 

при розробці принципових електричних схем? 
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4. Яка особливість інтерфейсу програми AutoCAD Electrical?  

5. Як використовуються бібліотеки УГП у програмі AutoCAD 

Electrical? 

6. Як створити та додати новий електричний компонент у 

AutoCAD Electrical? 
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Лабораторна робота 6 

Розробка принципових електричних схем керування 

електроприводами  

 

Мета роботи 

Ознайомитися з особливостями креслення принципових 

електричних схем керування електроприводами та навчитися 

виконувати їх за допомогою програми AutoCAD Electrical 

 

Теоретичні відомості 

При розробці принципових електричних схем (ПЕС) 

застосовують: 

- творчий підхід; 

- оптимальне компонування елементарних електричних кіл і 

типових функціональних вузлів у єдину схему з урахуванням 

обмежень та можливого спрощення і мінімізації.  

Розробка принципових електричних схем розглядається у 

контексті:  

- контролю; 

- керування; 

- регулюванням проектованого об'єкта.  

Принципова електрична схема повинна бути спроектована 

так, щоб її експлуатація у виробничих умовах була простою, 

потребувала мінімум витрат і уваги експлуатаційного персоналу, 

забезпечувала можливість проведення ремонтних і 

налагоджувальних робіт з дотриманням відповідних заходів 

безпеки.  

Графічне оформлення будь якої ПЕС потрібно виконувати 

зрозуміло, просто і компактно, так щоб це сприяло найкращому 

сприйняттю її змісту. 

Порядок розробки принципових електричні схем: 

1) на підставі технічного завдання складають чітко 

сформульовані технічні вимоги до ПЕС; 

2) відповідно до технічних вимог встановлюють умови і 

послідовність дії схеми; 

3) кожна із заданих умов дії схеми зображається у вигляді 

елементарних кіл; 
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4) елементарні кола поєднують у загальну схему; 

5) здійснюють вибір апаратури і виконують електричний 

розрахунок параметрів окремих елементів схеми; 

6) коректують схему відповідно до можливостей прийнятої 

апаратури; 

7) перевіряють у схемі можливість виникнення помилкових чи 

обхідних кіл або її неправильної роботи при ушкодженнях 

окремих кіл чи контактів; 

8) розглядають можливі варіанти і приймають остаточне 

рішення. 

При розробці ПЕС важливу роль відіграє використання 

загальноприйнятих стандартів оформлення. Зокрема, для 

позначення електричних кіл застосовують арабські цифри і 

прописні літери латинського (іноді кириличного) алфавіту. 

Наприклад, у ДСТУ передбачено позначати ділянки кіл: 1, 25, 

104; фази А1, В1 С1 або А, В, С; N - нульовий робочий провід; РЕ 

- нульовий захисний провід, тощо. Такий підхід дуже важливий, 

як при розробці самої схеми так і для подальшого виконання на її 

основі інших схем. Усі електричні компоненти та пристрої, 

відображені на ПЕС, повинні бути однозначно визначені і 

записані в перелік елементів і пристроїв за формою відповідно до 

ГОСТ 2.702-75. 

Розглянемо приклад розробки принципової схеми керування 

2-ма електродвигунами, яка зображена на рис. 6.1. Пуск 

асинхронних двигунів здійснюється за допомогою магнітних 

пускачів котушки, яких КМ1, або КМ2 будуть замикати робочі 

контакти, а, отже, і подавати напругу на двигуни 1М, або 2М при 

натисканні кнопок 1SВ2, або 2SВ2. При чому, це можна 

здійснити тільки в ручному режимі, коли перемикач 1SА1 (2SА1) 

перебуває в положенні Р. При цьому контактор КМ1 (КМ2) через 

свій власний контакт КМ1.1 (КМ2.1) заблокуються.  

Вимикання двигуна 1М (2М) здійснюється при натисканні на 

кнопку 1SВ1 (2SВ1). У положенні А, перемикача 1SА1 (2SА1), 

що відповідає автоматичному режиму, двигуни будуть вмикатися 

автоматично за допомогою контактів реле К4 (КЗ), які 

управляються контролером і показані на іншій принциповій 

схемі. На це вказує штрих-пунктирна лінія навколо цих контактів 
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і посилання на певний номер аркуша принципової схеми. При 

перевантаженні двигуна спрацьовує теплове реле КК1 (КК2) 

розмикаючий контакт, якого припиняє подачу напруги на 

котушку контактора КМ1 (КМ2). 

  
Рис. 6.1. Принципова електрична схема керування 2-ма 

асинхронними електродвигунами 

 

Зв’язок принципової схеми з переліком елементів (табл. 6.1) 

здійснюється через позиційні позначення. При цьому в графі 

«Назва», крім назви типу і марки, приводяться основні технічні 

характеристики елемента або пристрою. Наприклад, для двигунів 

1М, 2М вказується номінальні потужність, частота обертання, 

напруга і струм. В окремих випадках допускається всі відомості 

про елементи поміщати біля умовних графічних позначень 

(наприклад, параметри резисторів і конденсаторів). 

Для виконання креслень принципових електричних схем 

зручним та ефективним інструментом програми AutoCAD 

Electrical є можливість роботи над проектом/ми. Для цього 

використовується вкладка «Проект» (рис. 6.2), яка надає всі 

можливості для організації документів цілого проекту. У функції 

«Диспетчер проектов», використовуються опції для 

заощадження часу та підвищення продуктивності під час роботи 

над проектом. Це дозволяє створювати проекти, редагувати, 

повторно позначати компоненти, вносити зміни до файлу з 

документами проекту та отримувати доступ до опцій експорту з 

інших проектів. 
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Таблиця 6.1 

Перелік елементів та пристроїв принципової електричної схеми  

 
 

 
Рис. 6.2. Інтерфейс AutoCAD Electrical при виборі панелі 

«Проект» 

 

Основним робочим простором при проектуванні принципових 

електричних схем у програмі AutoCAD Electrical є середовище з 

відповідним набором інструментів, яке активізується при виборі 

панелі «Схема». При виборі панелі «Конструктор цепей» 

Позиційне 

позначення 

Назва Кіль-

кість 

Примітка 

На механізмі 

1М, 2М Двигун асинхроний 3ф., тип 

МDХМА90-32,1,5кВт, 1410хв
-1

, 380В, 

3,5А 

2  

На щиті місцевого управління (ЩМУ) 

QF Вимикач автоматичний ТеmDіn 3С, 

In=10A; Un=380В 

1  

КМ1, КМ2 Контактор типу 11МС6.10, In=6А, 

 Uк=220В, 1 зам. дод. Контакт 
2  

КК1, КК2 Реле теплове, тип 11RF9,5, Iср=3-5А 2  

1QF1,  

2QF1 

Вимикач автоматичний, тип ТеmDіn 

1С, In=1A; Un=220В 

2  

1SB1, 

2SB1 

Кнопка управління, тип 

8LМ2ТВ104.1 розмірний контакт, 

штовхач червоного кольору 

2 На дверях 

ЩМУ 1 

1SB2,  

2SB2 

Кнопка управління, тип 

8LМ2ТВ102.1 зам. контур, штовхач 

чорного кольору 

2 На дверях 

ЩМУ 1 

1SА1, 

2SА1 

Перемикач, 3-поз. стабільний, тип 

8ДМ2ТS130 

2 На дверях 

ЩМУ 1 

1НL1, 

2НL1 

Арматура світлосигнальна зелена, 

тип 8LР2ТIL223, з лампою 

розжарювання 220В змінного струму 

2 На дверях 

ЩМУ 1 
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програма AutoCAD Electrical пропонує вибрати доступні 

електричні кола, які вже є готовими до використання (рис. 6.3). 

Серед таких кіл можна вибрати найбільш підхоже для 

подальшого використання, або подібне до того, яке потрібно 

розробити. При натисканні кнопки «Настроить» відкривається 

меню, що дозволяє налаштувати вибрану схему під особливі 

параметри, серед яких: налаштування двигуна, графічне 

відображення двигуна, виводи клем та ін. При натисканні кнопки 

«Вставить» програма автоматично створює типову схему, яку 

потім можна налаштовувати та змінювати (рис. 6.4).  

 

 
Рис. 6.3. Зовнішній вигляд меню для вибору існуючої 

принципової електричної схеми 

 

Для того, щоб на схемі видалити зайвий компонент, то його 

потрібно виділити та натиснути на клавішу «Delete», а 

електричний провід у місці розриву з’єднати за допомогою 

кнопки «Провод», що на панелі меню «Вставить провода / номер 

проводов». Якщо ж на схему потрібно вставити новий компонент, 

то для цього можна використати «Обозреватель каталогов» на 
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панелі «Вставить компонент» після чого з вкладки 

«Категория» вибрати необхідну категорію, наприклад 

«Выключатели», потім вказати конкретну марку чи модель та 

вибрати її з каталога доступних виробників, як це показано на 

рис. 6.5. Якщо необхідного компонента немає, то його можна 

віднайти застосувавши кнопку «Глобальній поиск», або вибрати 

інший, який є в наявному каталозі. При виборі вказаного 

компоненту та підведенні його до електричної лінії програма 

автоматично вставить компонент у вказане місце створивши у 

ньому розрив та прив’яже його до вказаного електричного кола. 

 

 
Рис. 6.4. Зовнішній вигляд вставленої принципової електричної 

схеми керування трифазного нереверсивного двигуна 

 

 
Рис. 6.5. Зовнішній вигляд меню «Вставить компонент» при 

додаванні компонентів електричних схем з каталогу виробників 
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Якщо при виборі у каталозі необхідний графічний образ не 

відображається, або він відсутній, то його можна віднайти за 

допомогою графічного меню «Вставить компонент», що 

автоматично відкриється. Також це меню можна відкрити з 

головної панелі «Схема» (див. лабораторну роботу 3). Зовнішній 

вигляд  меню для пошуку та вставлення компоненту показано на 

рис. 6.6. У графах меню віднаходимо необхідний компонент, або 

його аналог та вставляємо у відповідне місце. 

 

 
Рис. 6.6. Зовнішній вигляд меню для пошуку та вставлення 

компоненту 

 

Після виконання вибору відповідного елементу та виконання 

команди «Вставка образа, выбраного в графическом меню» 

відкриється вікно «Вставить / Редактировать компонент» (рис. 

6.7). При цьому, вказуються автоматичні дані компонента з 

вибраного каталогу, а також тут можна ввести необхідні дані, 

наприклад виводи, номінальні значення, позиційні позначення та 

інші. Вказані в даному меню опції будуть зв’язувати компонент з 

відповідним його відображенням на монтажній схемі, а також 

вони можуть використовуватися при автоматичному формуванні 

звітів та специфікацій.   
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Рис. 6.7. Вигляд вікна «Вставить / Редактировать компонент» 

 

Після цього, необхідний електричний компонент можна 

вставити у відповідному місті схеми на провіднику/ах, а програма 

автоматично виконає їх з’єднання. Якщо необхідно вставити 

новий провід, чи відредагувати існуючий, то це можна зробити 

використавши вкладку «Провод», яка знаходить на  панелі 

«Вставить провода/номера проводов». В процесі розстановки 

провідників AutoCAD Electrical автоматично прив’язує кінці 

проводів та виконує їх маркування до вибраних (вставлених) 

електричних елементів. При необхідності редагування 

компонента використовують відслідковуване (контекстне) меню 

про яке описано в лабораторній роботі 5.   

Для створення «Переліку елементів та пристроїв», 

електричної схеми у вигляді специфікації можна 

використовувати інструмент генерування звітів. Для цього 

необхідно перейти на вкладку «Отчеты» та натиснути кнопку 

«Отчеты» (рис. 6.8.). В отриманому списку вибрати 

«Спецификация» або «Табличка», а в наступному вікні 

перевірити чи для кожного компоненту вказано виробника та 

номер за каталогом (марку, модель пристрою).  

Якщо виробник та номер за каталогом у певного компонента 

принципової електричної схеми відсутні, необхідно скасувати 

створення специфікації та відредагувати атрибути елемента, 

додавши відсутні дані у відповідні поля. Після цього, 
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специфікацію необхідно розмістити на кресленні натиснувши 

кнопку «Вставить в чертеж», що на панелі «Формирование 

отчетов». 

 

 
Рис. 6.8. Зовнішній вигляд панели «Отчеты» 

 

Програма роботи  

1. Розглянути основні правила розробки принципових 

електричних схем керування електроприводами та особливість 

використання програми AutoCAD Electrical для їх розробки.  

2. Використовуючи базу умовних графічних позначень 

навчитися розробляти принципові електричні схеми керування 

електроприводами. 

 

Порядок виконання роботи 

1. Розглянути правила розробки принципових електричних 

схем керування електроприводами та особливість використання 

програми AutoCAD Electrical, що описано у теоретичних 

відомостях. 

2. Вибрати варіант виконання принципової електричної 

схеми керування електроприводами за вказівкою викладача та 

розглянути принцип його дії, а також всі умовно-графічні та 

літерно-цифрові позначення, які використані в цій схемі. 

3. Створити новий проект у програмі AutoCAD Electrical. Для 



 

88  

цього запустіть програму та виберіть Создать > Выбор шаблона 

ACAD_ELECTRICAL_IEC.dwt або ACAD_ELECTRICAL.dwt, або 

інший підхожий для цієї схеми. 

Зауваження. Для вибору стандартної рамки з кутовим 

штампом з наявних у шаблонах AutoCAD перейдіть за 

посиланням: Файл > Создать > Создание нового чертежа > 

Чертеж та виберіть один з варіантів оформлення. 

4. Відкрити проект на панелі меню «Схема» у вкладці панелі 

«Конструктор цепей» вибрати доступну принципову електричну 

схему керування, яка найбільш підхожа для призначеного 

варіанту. Використовуючи кнопку «Настроить» за допомогою 

відповідно меню налаштувати вибрану схему під параметри 

вказані у варіанті. 

5. Вставити необхідні електричні компоненти схеми за 

допомогою вкладки «Вставить компонент». Для цього виберіть 

«Обозреватель каталогов» або «Графическое меню та з каталогу 

виробників виберіть найбільш підхожі до вибраної схеми 

компоненти, що відповідають варіанту схеми та вставте їх у 

певних місцях на робочому полі схеми, або на відповідних 

електричних лініях у відповідності до варіанту. При відсутності 

конкретного електричного компоненту у списку виробників що 

представлені в AutoCAD Electrical вибрати аналог з графічного 

меню «Вставить компонент». 

6. Видалити зайві електричні компоненти та фрагменти 

електричних кіл привівши схему до вигляду, що вказаний у 

варіанті. 

7. Виконати з’єднання, або редагування вибраних та 

встановлених на робоче поле елементів провідниками з меню 

«Вставить провода/номер проводов > Провод». 

8. Виконати остаточне оформлення схеми, додати перелік 

використаних елементів у вигляді специфікації на полі схеми, або 

на додатковому аркуші, так як це показано на рис. 6.8 

теоретичних відомостей.  

9. Результати виконання роботи оформити у вигляді звіту на 

стандартних аркушах формату А4. Креслення принципової 

електричної схеми виконати на окремому аркуші з рамкою та 

заповненим кутовим штампом. Додатково надати для перевірки 
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виконаний файл у форматі .dwg. 

 

Вимоги до оформлення звіту  

Звіт повинен містити: 

- титульний аркуш; 

- мету роботи; 

- програму та порядок виконання роботи; 

- скріншоти виконання основних етапів побудови, які описані 

у порядку виконання роботи; 

- креслення розробленої принципової електричної схеми на 

окремому аркуші стандартного розміру (А3-А1) з рамкою та 

заповненим основним написом; 

- перелік використаних елементів у вигляді специфікації; 

- висновок. 

 

Контрольні запитання 

1. У чому суть розробки принципових електричних схем? 

2. Яка особливість програми AutoCAD Electrical? 

3. Які переваги використання програми AutoCAD Electrical 

при проектуванні принципових електричних схем? 

4. Яка особливість інтерфейсу програми AutoCAD Electrical?  

5. Як використовуються бібліотеки УГП у програмі AutoCAD 

Electrical? 

6. Яка специфіка використання AutoCAD Electrical при 

використанні панелі «Конструктор цепей»? 
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Лабораторна робота 7 

Розробка 3D-моделей в програмі Autodesk Inventor 

 

Мета роботи 

Ознайомитися з особливостями креслення 3D-моделей у 

програмі Autodesk Inventor. Навчитися використовувати основні 

операції з 3D-моделювання в програмі Autodesk Inventor.  

 

Теоретичні відомості 

Для розробки складних 3D-моделей широко застосовують 

програму Іnventor, яка є продуктом компанії Autodesk. Іnventor 

являє собою програму для виконання креслень та конструювання 

у різних сферах промисловості. Для початку роботи з програмою 

варто налаштувати її основні параметри та персоналізувати 

основні дані. Це можна зробити за допомогою меню 

«Параметры», яке знаходиться у вкладці «Файл». В процесі 

налаштування параметрів програми Autodesk Inventor необхідно 

ввести дані в закладки «Общие», «Файлы» «Цвета» та інші за 

бажанням користувача. Зокрема у закладці «Общие» введіть 

прізвище та ініціали, а також вкажіть «Параметры захвата-

привязки» так як це показано на рис. 7.1. У вкладці Файлы при 

натисканні кнопки  має бути налаштовано 

одиниці вимірювання – міліметри, а стандарт оформлення – 

GOST. На вкладці «Цвета» можна налаштувати кольори 

виведення деталі, кольорову схему активного вікна та тип 

інтерфейсу – темна або світла. Також можна виконати 

налаштування різних вкладок, зокрема «Чертеж», «Эскиз» та 

інших.  

Створення 3D-моделей в Autodesk Inventor відбувається у 

спеціальному середовищі, яке містить усі необхідні команди та 

операції. Для початку вибираємо з меню програми: «Начало 

работы > Создать > Деталь». Після цього відкриється вікно 

побудови 3D-моделі з відображенням дерева побудови та 

робочого простору.  
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Рис. 7.1. Налаштування параметрів програми Autodesk Inventor 

 

Розглянемо приклад створення простої 3D-моделі 

паралелепіпеда з чотирма отворами. Для початку виконуємо 

послідовність дій: «Файл>Cоздать>Деталь». Один зі способів 

створення 3D-моделі – це креслення 2D-ескізу. Для початку 

створення ескізу натискаємо на кнопку , яка знаходиться у 

верхньому правому куті програми. У процесі побудови ескізу 

необхідно спочатку вибрати площину в якій будемо будувати 

ескіз, на ній креслимо сам ескіз. Після завершення виконання 

ескізу натикаємо на кнопку , потім на кнопку Принять эскиз 

, яка забезпечує вихід з процесу побудови ескізу та здійснює 

вихід з робочої зони побудови ескізу (рис. 7.2). 

Для створення 3D-моделі паралелепіпеда переходимо на 

вкладку «3D-модель», вибираємо панель «Cоздать > 

Выдавливание». У вкладці «Расстояние» вибираємо необхідну 

висоту деталі, у нашому прикладі висота становить - 10 мм (рис. 

7.3). 
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Рис. 7.2. Побудова ескізу  

 

 
Рис. 7.3. Побудова 3D-моделі з ескізу 

 

Для створення отворів, або інших елементів на 3D-моделі 

виконуємо операції, які подібні до операцій побудови моделі в 

програмі AutoCAD. Наприклад, щоб побудувати 4-и отвори на 

площині паралелепіпеда необхідно спочатку побудувати один 

отвір за допомогою панелі «Cоздать», визначити ескізний центр 

одного з отворів за допомогою функції «Точка». Вибираємо у 

«Дерево построєний» (панель ліворуч) необхідний «Эскиз2», 
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потім вибираємо «Cоздать>Точка» (рис. 7.4, а). Визначаємо 

розмір отворів та їх розташування і вирізаємо один наскрізний 

отвір за допомогою вкладки «3D-модель» панель «Изменить > 

Отверстие». У відповідному вікні обираємо потрібний діаметр 

отвору, у нашому випадку - 10 мм (рис. 7.4, б). 

Для сворення 3-х інших отворів використовуємо функцію 

«Прямоугольный массив». Вибираємо вкладку «3D-модель» 

панель «Масив > Прямоугольный массив» (рис. 7.4, в). У вікні 

«Прямоуг. масив» вибираємо два напрямки розташування отворів 

та інтервал між ними.  
 

 
а 
 

 
б 



 

94  

 
в 

Рис. 7.4. Процес створення отворів 

 

У програмі Autodesk Inventor є можливість створювати моделі 

з визначенням їх фізичних параметрів, тобто матеріалу деталі. 

Для завершення створення деталі паралелепіпеда з отворами 

обираємо матеріал з якого він буде виготовлятися, це можна 

зробити за допомогою випадаючого меню та обрати матеріал, 

наприклад «Резина», як на рис. 7.5, або будь який інший. 

 

 
Рис. 7.5. Вибір матеріалу деталі 

 

Для побудови додаткових елементів 3D-моделі, або її 
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модифікації можна використовувати подібні принципи побудови, 

як при кресленні 3D-моделей в програмі AutoCAD. Наприклад, 

для додавання конуса або циліндра до паралелепіпеда створюємо 

на його площині ескіз майбутньої фігури (рис. 7.6, а), а потім 

виконуємо її побудову за допомогою команд, що знаходяться на 

вкладці «Создать», наприклад «Видавливание» (рис. 7.6, б). 

Після цього, за допомогою контекстного меню «Свойства» 

задаємо необхідні параметри нового елемента 3D-моделі (рис. 

7.7) 

 

  
                 а                                                    б 

Рис. 7.6. Вигляд ескізу нового елемента (а) та елементів панелі 

Создать (б) 

 

 
Рис. 7.7. Використання контекстного меню Свойства  
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Після розробки 3D-моделі необхідно виконати її креслення на 

аркушах паперу відповідного формату та нанести розміри. Для 

цього використовують дерево побудови. На назві деталі 

клацають ПКМ та з контекстного меню вибирають команду 

«Создать чертеж» (рис. 7.8). 

 

 
Рис. 7.8. Створення креслення деталі 

 

Після вибору опції «Создать чертеж» необхідно сформувати 

відповідні види креслення 3D-моделі за допомогою меню «Вид 

чертежа» та розташувати його в межах стандартного аркуша 

(рис. 7.9). При потребі можемо задати «Масштаб» за допомогою 

відповідної вкладки меню «Вид чертежа». 

Після формування видів потрібно вказати розміри готового 

креслення. Це можна зробити за допомогою опції нанесення 

розмірів на види креслення, яка знаходиться на вкладці 

«Пояснение > Размеры» (рис. 7.10). 

Для заповнення та формування основного напису на кресленні 

використовуємо спеціальну опцію для заповнення основного 

напису креслення. Для того, щоб це опція меню відображалася у 

Inventor її потрібно ввімкнути (якщо вона вимкнена). Для її 

вмикання потрібно перейти за посиланням “Среды > кнопка 

Управление > Надстройки > Диспетчер надстроек > 

Поддержка ESKD”. Далі потрібно ввімкнути галочки навпроти 
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опцій: “Загрузить/выгрузить” та “Загружать автоматически”. 

Після цього, на вкладці “Листы чертежа > Основная надпись”, 

з’являється можливість виконувати введення та редагування 

даних основного напису (Рис. 7.11).  
 

 
Рис. 7.9. Створення розташування видів креслення  

 

 
Рис. 7.10. Процес нанесення розмірів на види креслення 
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Рис. 7.11. Формування та редагування основного напису 

креслення 

 

Розглянуті у даному прикладі особливості проектування 3D-

моделей дають змогу навчитися виконувати побудови різних за 

складністю об’ємних конструкцій з використанням програми 

Autodesk Inventor. 

 

Програма роботи 

1. Ознайомитися з принципами та правилами побудови 3D-

конструкцій у програмі Autodesk Inventor. 

2. На основі описаних у теоретичних відомостях операцій та 

команд виконати побудову 3D-деталі за варіантом. 

 

Порядок виконання роботи 

1. Розглянути приклад створення 3D-моделі у програмі 

Autodesk Inventor (використано версію програми - 2022), який 

описано у теоретичних відомостях. 

2.  Налаштувати основні параметри програми Autodesk 

Inventor та персоналізувати основні дані розробника. 

3. Використовуючи варіант деталі, що виконана у лабораторній 
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роботі 3, розробити 3D-модель за допомогою операції та команд 

програми Autodesk Inventor, що розглянуті у теоретичних 

відомостях. 

4. Виконати оформлення готового креслення 3D-моделі на 

аркушах паперу формату А3 розмістивши головні види (спереду, 

збоку, зверху) та ізометричний вид так, як це показано на рис. 7.10 

(залежить від розміру моделі).  

5. Нанести всі необхідні розміри та заповнити основний напис 

креслення вказавши матеріал деталі (визначити довільно) та 

масштаб.  

Зауваження. Якщо розроблена 3D-модель не поміщається на 

форматі А3, тоді використайте відповідний масштаб зменшення. 

6. Результати роботи оформити у вигляді звіту на 

стандартних аркушах формату А4, а також надати виконаний 

файл 3D-моделі у форматі .ipt для перевірки. До звіті необхідно 

додати креслення деталі у трьох стандартних виглядах (спереду, 

збоку, зверху) та ізометричний (3D- модель) на окремому аркуші 

стандартного розміру А3 з вказаними розмірами та заповненим 

основним написом. 

 

Вимоги до оформлення звіту  

Звіт повинен містити: 

- титульний аркуш; 

- мету роботи; 

- програму та порядок виконання роботи; 

- скріншоти виконання основних етапів побудови, які описані 

у порядку виконання роботи; 

- креслення 3D-моделі на окремому аркуші стандартного 

розміру А3 з заповненим основним написом; 

- файл 3D-моделі у форматі .ipt 

- висновок. 

 

Контрольні запитання. 

1. Як виконати розробку ескізу 3D-моделі у програму 

Autodesk Inventor? 

2. Як виконати розробку 3D-моделі у програму Autodesk 

Inventor? 
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3. Як здійснюється переміщення компонентів по простору 

зборки? 

4. Як відбувається додавання та віднімання елементів до 3D-

моделі? 

5. Яка особливість та способи використання функції 

«Прямоугольный массив»? 

6. Як відбувається оформлення креслення 3D-моделі у 

програму Autodesk Inventor? 
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Лабораторна робота 8 

Розробка складального креслення 

 

Мета роботи 

Ознайомитися з особливостями розробки складального 

креслення 3D-конструкцій. Навчитися виконувати складальні 

креслення у програмі Autodesk Inventor 

 

Теоретичні відомості 

Складальним (збірним) називається креслення, яке містить 

зображення виробу та інші дані, потрібні для його складання 

(виготовлення) і контролю. Згідно з ГОСТ 2.109–73 складальне 

креслення повинне мати [1]: 

1. Зображення складальної одиниці, яке дає уявлення про 

розміщення та взаємні зв’язки складових частин виробу. 

2. Вказівки про характер спряження і методи його виконання; 

 3. Вказівки про виконання нероз’ємних з’єднань (зварних, 

паяних та iн.). 

4. Номери позицій складових частин виробу. 

5. Розміри з граничними відхиленнями та інші параметри і 

вимоги, що мають бути виконані і проконтрольовані за цим 

складальним кресленням. 

6. Габаритні розміри виробу. 

7. Установлювальні, приєднувальні та інші необхідні 

довідкові розміри.  

Всі складові частини виробу нумерують у відповідності до 

номерів позицій, означених у специфікації складальної одиниці. 

Номери позицій вказують на полицях ліній-виносок. Цифри 

розміщають на одній горизонтальній (рядок) або вертикальній 

(колонка) лінії та позначаються шрифтом, розмір якого на один-

два номери більший, ніж у розмірних чисел.  

Специфікація - це документ, який визначає склад складальної 

одиниці, потрібний для виготовлення конструкторських 

документів і для запуску виробу у виробництво. Специфікацію 

виконують на окремих аркушах формату А4 

Послідовність виконання складального креслення: 

1. Ознайомлення з конструкцією виробу. 
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2. Встановлення порядку (послідовності складання виробу). 

3. Складання схеми розподілу виробу на складові частини. 

4. Формування позначень частин виробу і внесення їх у 

складальну схему. 

5. Виконання робочих креслень всіх деталей виробу. 

6. Визначення необхідних зображень виробу. 

7. Формування масштабу зображення в залежності від 

розмірів виробу. 

8. Намічають необхідні розрізи, перерізи і додаткові 

зображення. 

9. Вказують розміри та виносні лінії. 

10. Виконують специфікацію.  

11. Розробляють складальне креслення виробу за допомогою 

комп’ютерних програм. 

Розлянемо розробку складального креслення (зборки) в 

програмі Autodesk Inventor. Розробка складального креслення 

відбувається у спеціальному середовищі роботи зі зборками, яке 

містить усі необхідні команди та операції (рис. 8.1). Для початку 

вибираємо з меню програми: Файл>Создать>Сборка. Після 

цього відкриється вікно зборки, яке не містить ніяких елементів.  

 

 
Рис. 8.1. Початкове вікно зборки програми Autodesk Inventor 

 

Для додавання першої деталі зборки необхідно вибрати 

головну, або найбільшу деталь (елемент) зборки, яка 
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залишатиметься нерухомою (рис. 8.2). Щоб вставити деталь, 

натискаємо кнопку  «Вставить», яка знаходиться у 

верхньому лівому кутку робочого вікна та вибираємо деталь, 

наприклад, з попередньої лабораторної роботи. Натискаємо на 

робоче місце на яке потрібно вставити деталь. При потребі 

встановлення копій однієї і тієї ж деталі можна клацнути в 

іншому робочому місці і копія деталі буде додана. Після 

завершення вставлення відміняємо операцію клавішою «Esc». 

Для переміщення компонентів по простору зборки 

використовують звичайне захоплення мишею, або команди 

«Свободное пересещение» і «Свободный поворот». 

 

 
Рис. 8.2. Додавання першої деталі зборки 

 

Зауваження. У деяких випадках для додавання деталей 

розроблених у інших програмах, наприклад, таких, як AutoCAD 

необхідно виконати їх імпортування. Для цього потрібно 

скористатися панеллю «Начало работы» и кнопкою 

«Открыть», а у вкладці «Параметры открытия файла» 

вибираємо опцію «Импорт DWG» і дотримуючись подальших 

вказівок системи виконуємо імпортування розробленої деталі з 

інших програм. Під час імпортування у вкладці «Настройка 

целевых параметров» потрібно вставити галочку у вікно «3D 

тела». Інші опції можемо залишити по замовчуванню. Після 
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виконання імпорту відкриваємо вкладку з імпортованою деталлю 

та зберігаємо деталь присвоюючи їй нове ім’я. В результаті ми 

отримаємо деталь із оновленою геометрію, закриваємо відкриті 

файли. 

Один з компонентів зборки обов’язково повинен бути 

базовим, тобто мати фіксоване положення. Це дозволить 

уникнути зайвих переміщень і дасть можливість знизити появу 

помилок у процесі побудови моделі. Для цього наведемо курсор 

миші на деталь та натиснемо ПКМ, у спливаючому меню 

вибираємо «Базовый» (рис. 8.3). Якщо зборка складається з двох 

або більше однакових деталей, то їх можна скопіювати та 

розташувати поряд з базовою деталлю (рис. 8.4). 

 

 
Рис. 8.3. Формування базової деталі зборки 

 

У розглянутому прикладі дві однакові деталі будуть 

з’єднуватися за допомогою гумової прокладки між ними. Для 

створення гумової прокладки виконуємо послідовність дій: 

Файл>Cоздать>Деталь. Після цього відкриється вікно 

побудови нової деталі. Далі необхідно створити ескіз проклади 

(рис. 8.5). 
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Рис. 8.4. Розташування інших деталі відносно базової 

 

 
Рис. 8.5. Побудова ескізу проклади 

 

Для створення 3D-моделі гумової прокладки переходимо на 

вкладку «3D-модель», вибираємо панель «Cоздать» > 

«Выдавливание». У вкладці «Расстояние» вибираємо необхідну 

висоту деталі прокладка, у нашому прикладі висота становить – 

5 мм (рис. 8.6). 
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Рис. 8.6. Побудова 3D-моделі гумової прокладки з ескізу 

 

Зауваження. 3D-модель прокладки можна виконати у 

Inventor, а також її можна зробити у програмі AutoCAD, 

обрізавши верх деталі, що була створена у попередній 

лабораторній роботі та за допомогою опції «Импорт» додати у 

Inventor, як це описано вище. 

Для створення 4-х отворів болтового з’єднання визначаємо 

ескізний центр одного з отворів за допомогою функції «Точка». 

Вибираємо у «Дерево построєний» (панель ліворуч) необхідний 

«Эскиз2», потім вибираємо «Cоздать» > «Точка» (рис. 8.7, а). 

При цьому, розмір отворів та їх розташування визначаємо з 

отворів деталей, які будемо з’єднувати. Далі вирізаємо 

наскрізний отвір за допомогою вкладки «3D-модель» панель 

«Изменить» > «Отверстие». У відповідному вікні обираємо 

потрібний діаметр отвору, у нашому випадку - 10 мм (рис. 8.7, б). 

Для сворення 3-х інших отворів використовуємо функцію 

«Прямоугольный массив». Вибираємо вкладку «3D-модель»> 

панель «Масив»>«Прямоугольный массив» (рис. 8.7, в). У вікні 

«Прямоуг. масив» вибираємо два напрямки розташування отворів 

та інтервал між ними.  
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а 

 

 
б 

 

 
в 

Рис. 8.7. Процес створення отворів гумової прокладки 
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Для завершення створення гумової прокладки потрібно 

обрати матеріал з якого вона виготовлена, це можна зробити за 

допомогою випадаючого меню та обрати матеріал, у нашому 

прикладі це - «Резина» (рис. 8.8). 
 

 
Рис. 8.8. Вибір матеріалу гумової прокладки 

 

Для завершення підготовки деталей до зборки, створену 

гумову прокладку необхідно зберегти у ту ж папку на диску де 

знаходиться базова деталь. Після збереження у зборку (дерево 

побудови) додається гумова прокладка у тій же послідовності 

(див. опис вище), що і інші деталі зборки (рис. 8.9). У результаті 

в дереві побудови та у робочому вікні зборки маємо три деталі. 
 

 
Рис. 8.9. Додавання деталей до зборки 
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Для накладення складальних залежностей і обмежень та 

взаємного переміщення компонентів зборки в Autodesk Inventor 

існує дві команди: «Зависимость» і «Соединение». Ці команди 

знаходяться на панелі «Сборка». Різниця між ними полягає в 

тому, що за допомогою залежностей накладаються геометричні 

обмеження між компонентами (поєднання площин, співвісність, 

розташування під кутом та ін.), а за допомогою з’єднань 

створюються реальні фізичні поєднання компонентів (вставка осі 

в отвір, шарнір, повзун тощо).  

У нашому випадку використовуємо команду «Зависимость». 

Для цього обираємо вкладку «Сборка» панель «Взаимосвязи»> 

«Зависимость» (рис. 8.10, а). Вибираємо першу точку, криву, 

грань або робочий елемент та натискаємо «Выбор» «1» - для 

активації можливості вибору (рис. 8.10, б). При потребі, 

вибираємо другий варіант кнопкою «Выбор» «2» (рис. 8.10, в). 

Для встановлення залежності натискаємо на кнопку 

«Применить» (рис. 8.10, г). 

 

 
а 
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б 

 
в 

 

 
г 

Рис. 8.10. Використання команди «Зависимость» 
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Для вирівнювання гумової прокладки з базовою деталлю у 

меню «Зависимости в сборке» натискають на кнопку 

«Заподлицо» (рис. 8.11, а). Результат вирівнювання двох деталей 

зображено на рис. 8.11, б. 

 

   
а                                                      б 

Рис. 8.11. Результат вирівнювання двох деталей 

 

По аналогії проводять вирівнювання по осі Y (рис. 8.12, а) та 

створюють залежність другої деталі з гумовою прокладкою, яка 

розміщена на базовій деталі. У результаті отримаємо взаємне 

розташування всіх деталей зборки (рис. 8.12, б). 

  

  
   а                                                        б 

Рис. 8.12. Взаємне розташування всіх деталей 

 

Для того, щоб виконати болтове з’єднання цих деталей 

обирають вкладку «Вставка» > «Вставить из Библиотеки 
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компонентов» (рис. 8.13). У розглянутому прикладі 

використовують болт з діаметром різьби М10 та номінальною 

довжиною не менше 60 мм, гайку М10 та шайбу з внутрішнім 

діаметром 10 мм. 

Для з’єднання деталей за допомогою болтового з’єднання 

обирають вкладку «Взаимосвязи» > «Соединение» (рис. 8.14, а). 

Визначають першу точку, криву, грань або робочий елемент та 

при необхідності вибирають «Выбор» «1», або «Выбор» «2» (рис. 

8.14, б). Потім з’єднують обрані деталі. По аналогії з’єднують 

шайбу з геометрією отвору та гайку з різьбою (рис. 8.14, в). 

 

 
Рис. 8.13. Вибір елементів болтового з’єднання з «Библиотеки 

компонентов» 

 

Для того, щоб виконати з’єднання у інших 3-х отворах 

використовують функцію «Прямоугольный массив». Вибирають 

на вкладці «3D-модель» панель «Массив» > «Прямоугольный 

массив». У відповідному вікні потрібно обрати два напрямки 

розташування отворів та інтервал між ними (рис. 8.15). 
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а 

 

 
б 

 

 
в 

Рис. 8.14. З’єднання деталей за допомогою болтового з’єднання 
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Рис. 8.15. Побудова з’єднання всіх елементів 

 

Оскільки прокладка, яка знаходиться між двома деталями має 

тільки отвори під болтове з’єднання, а інші отвори відсутні, то 

необхідно відредагувати її так, щоб забезпечити повне 

співпадіння з елементами деталей. Для цього використовують 

функцію Autodesk Inventor - редагування деталей без їх окремого 

відкриття у новому вікні. Двічі клацаємо на моделі гумової 

прокладки та створюємо у ній новий ескіз (рис. 8.16). А за 

допомогою команди «Выдавливание» та режиму «Асиметрично» 

виконується витискання прокладки на необхідну відстань так, 

щоб вона заповнила всі порожнини (рис. 8.17). 

 

 
Рис. 8.16. Редагування ескізу деталі «Прокладка» 
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Рис. 8.17. Редагування деталі «Прокладка» 

 

Для того, щоб деталь «Прокладка» зайняла остаточне 

положення створюємо отвір у ребрі прокладки. Цю дію 

виконуємо за допомогою ескізу отвору на бічному ребрі 

прокладки та подальшому застосуванні команди 

«Выдавливание», як це показано на рис. 8.18. Після виконання 

всіх побудов отримують кінцеву зборку, яка відображена на рис. 

8.19. 

 

 
Рис. 8.18. Ескіз для утворення наскрізного отвору 
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Рис. 8.19. Результат створення зборки 3-х деталей 

 

Розглянуті у даному прикладі особливості розробки 

складального креслення (зборки) 3D-конструкцій дають змогу 

навчитися виконувати побудови різних за складністю зборок з 

використанням Autodesk Inventor. 

 

Програма роботи 

1. Ознайомитися з принципами та правилами побудови зборки 

елементів у програмі Autodesk Inventor. 

2. На основі приведеного у теоретичних відомостях прикладу 

процесу побудови складального креслення виконати побудову 

зборки деталей за варіантом. 

 

Порядок виконання роботи 

1. Розглянути приклад створення складального креслення у 

програмі Autodesk Inventor, який описано у теоретичних 

відомостях. 

2. Використовуючи 3D-модель деталі, що розроблена у 

попередній лабораторній роботі (за варіантом), виконати зборку 

деталей по аналогії за розглянутим у теоретичних відомостях 

прикладом. 

Зауваження. Для виконання побудови зборки на особистих 

комп’ютерах студентів використовують студентську ліцензію, або 
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тріал-версію програми Inventor, яку можна отримати після 

реєстрації на сайті autodesk.com.  

2.1. Відкриваємо 3D-деталь, яка була розроблена у лабораторній 

роботі 7. 

Зауваження. При необхідності додавання до зборки 3D-деталі, 

яка була розроблена у лабораторній роботі 3 необхідно виконати 

процес імпортування. Для цього, програмі Autodesk Inventor на 

вкладці «Начало работы» в меню «Открыть» вибрати файл 

розробленої раніше деталі, але замість натискання кнопки 

«Открыть», на панелі відкриття файлу, натиснути кнопку 

«Импорт DWG». Вказати деталь, яку будемо імпортувати і тільки 

після цього натиснути на кнопку «Открыть». У наступному вікні 

«Мастер файлов DWG/DXF» натискаємо кнопку «Далее» 

залишаючи всі опції за замовчуванням. Після цього в меню 

«Настройка целевых параметров» вибираємо «3D тела» та 

розмірності та натискаємо кнопку «Готово» (рис. 8.20). У 

результаті ми зможемо продовжувати виконання процесу зборки, 

як це показано на рис. 8.2 у теоретичних відомостях. 

 

 
Рис. 8.20. Відкриття файлу 3D-деталі розробленої в у прогамі 

AutoCAD у програмі Autodesk Inventor 

 

2.2. Зберігаємо відкриту (або імпортовану) деталь 

присвоюючи їй нове ім’я.  
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2.3. Вставляємо деталь/і у поле нової зборки, натискаючи 

кнопку «Вставить», яка знаходиться у верхньому лівому кутку 

робочого вікна та вибираємо деталь, з попередньої лабораторної 

роботи. Натискаємо на робоче місце на яке потрібно вставити 

деталь. Для встановлення копій однієї і тієї ж деталі (як у нашому 

випадку) можна клацнути в іншому місці робочого простору 

побудови. Після завершення вставлення відміняємо операцію 

клавішою «Esc». 

2.4. Розробити 3D-модель гумової прокладки. Гумова прокладка 

має відповідати контуру двох деталей і повинна мати отвори та 

вирізи, які є у верхньої та нижньої деталі зборки (див. рис. 8.16 - 

8.18). 

2.5. Додати до зборки болтове з’єднання з «Библиотеки 

компонентов» (див. рис. 8.13 – 8.15). 

2.6. Виконати остаточне з’єднання всіх деталей зборки за 

алгоритмом, який описаний у теоретичних відомостях. 

3. Результат виконання оформити у вигляді звіту на 

стандартних аркушах формату А4, а також надати виконаний 

файл зборки для перевірки. До звіті необхідно додати креслення 

розробленої зборки у трьох стандартних виглядах (спереду, 

збоку, зверху) та ізометрію на аркуші стандартного розміру (А3-

А1) з розмірами та заповненим основним написом.  

Зауваження. Процес оформлення готового креслення на 

аркушах паперу відповідного формату та нанесення розмірів 

детально розглянуто у лабораторній роботі 7. 

 

Вимоги до оформлення звіту  

Звіт повинен містити: 

- титульний аркуш; 

- мету роботи; 

- програму та порядок виконання роботи; 

- скріншоти виконання основних етапів побудови, які описані 

у порядку виконання роботи; 

- креслення зборки на окремому аркуші стандартного 

формату (А3-А1) у трьох стандартних виглядах (спереду, збоку, 

зверху) та ізометрію з розмірами та заповненим основним 

написом; 
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- файл креслення зборки у форматі .iam 

- висновок. 

 

Контрольні запитання. 

1. Що таке складальне креслення? 

2. Що таке специфікація? 

3. Як виконати додавання деталей розроблених у інших 

програмах у програму Autodesk Inventor? 

4. Як здійснюється переміщення компонентів по простору 

зборки? 

5. Як відбувається додавання деталей зборки? 

6. Яка особливість та способи використання функції 

«Прямоугольный массив»? 

7. Яка особливість створення болтового з’єднання?  

8. Як відбувається редагування деталей у вже готовій зборці? 
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Лабораторна робота 9 

Розробка креслень з листового матеріалу в програмі 

Autodesk Inventor  

 

Мета роботи 

Розглянути особливості розробки креслень з листового 

матеріалу та навчитися використовувати Autodesk Inventor для 

креслення окремих деталей та збірних конструкцій з листового 

металу 

 

Теоретичні відомості 

У процесі виробництва виникає необхідність надати заготовці 

з металу або сплаву певної форми, отримати виріб будь-якого 

розміру з різними характеристиками. Для цих цілей 

застосовується металообробка. Процес металообробки 

передбачає деформацію виробу, яка виконується за допомогою 

різних технологій. Поширеним способом металообробки є робота 

з листовим матеріалом. Креслення таких матеріалів застосовують 

для виготовлення складних виробів та конструкцій, наприклад 

виготовлення промислових щитів та пультів, конструкцій 

корпусів та блоків. 

Розглянемо приклад креслення конструкції промислового 

щита, який виконаний з листового металу. Для креслення 

конструкції з листового матеріалу використовуватимемо 

програму Autodesk Inventor, зокрема її опцію роботи з листовим 

тілом, яке формується витисканням ескізу у напрямку 

перпендикулярному до його площини. Перед побудовою 

листового тіла в деталі необхідно створити ескіз моделі, який 

буде визначати форму тіла. Для переходу в середовище 

створення ескізу потрібно виконати такі дії: Файл > Создать > 

Деталь. Після цього створюємо ескіз необхідного розміру (рис. 

9.1). В процесі створення ескізу, ми отримаємо зображення трьох 

перпендикулярних площин (XY, YZ і ZX), серед яких ми 

вибираємо ту, на якій будуємо ескіз. Вибір площини можна 

здійснити натисканням лівої кнопки миші (ЛКМ) або обрати в 

дереві побудови, зі списку, що з'являється після того, як обрали 

папку «Начало». 
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Рис. 9.1. Виклик команди створення ескізу 

 

Після створення ескізу скористаємося командою 

«Преобразовать в документ листового металла» 

інструментальної панелі «Преобразовать в». Виклик 

здійснюється натисканням на відповідній кнопці (рис. 9.2). 

 

 
Рис. 9.2. Перетворення ескізу в листовий метал 
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Параметри листового тіла задаються на вкладці «Параметры 

по умолчанию листового металла» (рис. 9.3) на панелі 

«Настройки». Для створення грані з листового металу 

скористаємося командою «Грань» на панелі «Создать» (рис. 9.4). 

 

 
Рис. 9.3. Перетворення ескізу в листовий метал 

 

 
Рис. 9.4. Процес створення грані 
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Якщо при створенні грані листового металу потрібно додати 

певну товщину цього матеріалу, то необхідну товщину можна 

встановити на вкладці Параметры по умолчанию листового 

металла (наприклад, 0,0015-0,015м). При цьому, перший 

створюваний елемент (грань) є базовим. Для наступних граней, 

якщо одна лінія в контурі збігається з уже існуючою кромкою 

листового металу, автоматично створюється згин, але для 

базового елемента параметри «Сгиб» і «Кромки» недоступні. 

Послідовність виконання побудови наступна:  

1. Побудуйте профіль, який представляє форму грані, яку 

необхідно створити. 

2. Виберіть «Листовой металл > панель Создать > 

Грань» . 

3. За наявності кількох профілів, натисніть «Профиль» і 

виберіть профіль для грані з листового металу. 

4. Якщо у файлі деталі є два і більше тіла, натисніть «Выбор 

тел», щоб вказати тіла, які будуть задіяні. 

5. Щоб змінити напрямок товщини грані, використовуйте 

вибір зі списку «Направление смещения»: 

- Натисніть кнопку «Сменить сторону»   або , щоб 

змістити товщину матеріалу по іншу сторону обраного профілю. 

- Виберіть «Обе стороны» , щоб змістити товщину 

матеріалу рівномірно на обидві сторони обраного профілю.  

6. Натисніть кнопку «ОК», щоб створити грань і закрити 

вікно. Якщо потрібно створити додаткові грані з листового 

металу, натисніть кнопку «Применить». 

У результаті виконання описаної послідовності отримаємо 

листове тіло, подібно до того, яке показано на рис. 9.5. 
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Рис. 9.5. Результат розробки початкової грані листового тіла 

 

Створити фланець бокових сторін можна вздовж ребра або 

контуру ребер. До існуючої межі листового металу можна додати 

ще одну грань листового металу і згин. При створенні фланця 

відобразиться його попередній вигляд вздовж обраного ребра з 

використанням параметрів за замовчуванням. Послідовність 

виконання фланця наступна: 

1. Виберіть вкладку «Листовой металл > панель Создать > 

Фланец ».  

2. На вкладці «Форма» виконайте одну з таких дій: 

- Для створення фланця вздовж ребра натисніть «Режим 

выбора ребра» і виберіть одне або кілька ребер. 

- Для створення фланця навколо контуру ребер натисніть 

«Режим выбора контура» і виберіть контур. 

3. У списку «Границы высоты» виконайте одну з таких дій. 

- Виберіть «Растояние» і введіть значення в списку. 

- Виберіть «До» і виберіть геометрію, яка визначає висоту 

фланця. 

4. При необхідності для зміни сторони грані листового 

металу, на якій створюється фланець, натисніть «Изменить 

направление». 
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5. Налаштуйте такі параметри: 

- «Угол фланца». Задавання кута фланця щодо межі з 

вибраними ребрами. 

- «Радиус изгиба». 

6. Щоб додати кілька фланців, натисніть кнопку 

«Применить».  

У результаті виконання описаної послідовності отримаємо 

листове тіло з фланцями необхідної висоти показана на рис. 9.6. 

 

 
Рис. 9.6. Листове тіло з фланцями необхідної висоти 

 

Передню частину конструкції щита будуємо також за 

допомогою інструменту «Фланец» (рис. 9.7). Для того, щоб двері 

майбутньої конструкції щита не провалювалися всередину, 

потрібно створити додаткові три фланці у які будуть опорою для 

них, а з лівої сторони щита будуть встановлені завіси на яких 

будуть закріплені двері.   
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Рис. 9.7. Побудова передньої частини щита 

 

Для задання ширини фланця використовуємо панель 

«Дополнительно» діалогового вікна «Фланец» на якій містяться 

додаткові способи задання ширини фланця за такою 

послідовністю: 

1. У правому нижньому кутку діалогового вікна «Фланец» 

клацніть «Подробности»  

2. У списку «Тип Границ» виберіть один з наступних 

варіантів: 

- Щоб створити фланець, який буде проходити уздовж всього 

ребра, виберіть «Ребро». 

- Щоб вказати певну ширину, клацніть «Ширина» та введіть 

значення. Щоб виправити зміщення фланця, вкажіть «По 

центру» або «Смещение». 

- Щоб у якості ширини використовувати зміщення, натисніть 

«Смещение» і вкажіть значення в списках, що розкриваються 

«Смещение 1» і «Смещение 2».. 

- Щоб використовувати значення з існуючої геометрії, 

виберіть «От/До», а потім виберіть початкову геометрію моделі 

для першого зсуву і кінцеву геометрію для другого зсуву. 

Для того щоб до моделі щита додати отвори для електричних 
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провідників (кабелів), завісів, вирізи під індикатори та 

перемикачі потрібно створити ескізи майбутніх отворів (рис. 9.8). 

Для цього використовуючи інструмент створення отворів 

вирізаємо отвір(и) (рис. 9.9) за такою послідовністю: 

1. Виберіть вкладку «3D-модель > Изменить > Отверствие 

». 

2. Задайте необхідні параметри отворів 

3. Натисніть кнопку «ОК» 

У результаті отримаємо отвори, як це показано на рис. 9.10. 

 

 
Рис. 9.8. Ескізи для виконання завісів та отворів 

 

 
Рис. 9.9. Інструмент створення отворів. 
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Рис. 9.10. Вигляд отриманих отворів на бічній поверхні  

 

Для створення отворів під кронштейни використаємо 

інструмент «Вирезать». Послідовність виконання вирізів 

розглянемо нижче, коли будемо вирізати отвори для елементів на 

дверях щита. 

При створенні ескізу профілю, який буде використовуватися 

для вирізу по згинах, рекомендується спроектувати на ескіз 

розгорнуту геометрію. Ця команда використовується для 

проектування плоскої грані разом з лініями згину, які можна 

використовувати для нанесення розмірів на ескіз. Це можна 

зробити за описаною нижче послідовністю. 

1. Спочатку виберіть плоску грань для створення ескізу, а 

потім за допомогою команди «Создать развертку» виберіть межі 

обраної грані ескізу.  

2. На вкладці ескіз створіть необхідний ескіз за відповідними 

розмірами, а потім виконайте команду «Вырезать» на панелі 

«Развертка». 

• За допомогою команди ескізу «Разделить», що 

знаходиться на вкладці «Изменить» видаліть геометрію моделі зі 

згином з площини ескізу. Якщо необхідно виконати декілька 

вирізів, то необхідно натиснути «Вибор тел». Після цього, можна 

вказати параметри вирізів: встановлюються глибина і напрямок 

вирізу: 

- Глубина: До следующего, До выбраного, От и до, Насквозь.  
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- Щоб задати товщину виберыть меню Толщина: 

- Вкажіть один з варіантів відступів: , , .  

Для створення дверей щита скористаймося тією ж 

послідовністю та інструментам, що розглянуті вище. 

Послідовність розробки дверей щита проілюстрована на рис. 9.11 

– 9.13. 

 

 
Рис 9.11. Розробка моделі дверей щита з листового тіла 

 

 
Рис. 9.12 Створення ескізу на розгортці дверей щита для 

утворення отворів (якщо потрібно) 
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Рис. 9.13. Вигляд готових отворів для встановлення обладнання 

на дверях щита 

 

Розробка складального креслення (зборки). За допомогою 

функції «Сборка» (Файл > Создать > Сборка) та болтових 

з’єднань, які детально розглядалися у попередній лабораторній 

роботі виконаємо складальне креслення щита (рис. 9.14). 

  

 
Рис. 9.14. Створення сборки корпуса та дверей щита 

 

Останнім кроком буде кріплення DIN-рейки за допомогою 

болтового з’єднання. Для цього нам потрібно відкрити модель 
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DIN-рейки, створити ескіз отворів для кріплення та використати 

інструмент «Отверстие», виконуємо подібно до попередніх 

етапів моделювання щита за послідовністю, яка показана на рис. 

9.15-9.18. 

 

 
Рис. 9.15 Ескіз створення отворів для болтового з’єднання DIN-

рейки 

 

 
Рис. 9.16. Отримані отвори для болтового з’єднання DIN-рейки 
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Рис. 9.17 Отвори у монтажній частині корпусу щита для 

болтового з’єднання 

 

 
Рис. 9.18. Вигляд закріпленої DIN-рейки на корпусі 

 

На завершення виконуємо болтове з’єднання. Для того, щоб 

вибрати необхідне з’єднання використаємо Бібліотеку 

компонентів (рис. 9.19). 
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Рис. 9.19. Готова модель щита з DIN-рейкою 

 

Для оформлення конструкторської документації на 

розроблений щит необхідно зберегти розроблену модель у 

вигляді креслення. Для цього необхідно натиснути “Файл > 

Создать > Чертеж”. Щоб відобразити розроблену модель щита 

в 3-х основних видах та ізометрії використовуємо функцію 

«Базовий» (рис. 9.20). Вибираючи відповідні сторони щита з опції 

«Размещение видов» створюємо його у відповідних проекціях. 

Для створення ізометричного виду зображення щита необхідно 

розмістити зображення у відповідній частині аркуша, зазвичай по 

діагоналі вниз від основного виду. В результаті ми отримуємо 

креслення щита в 3-х основних видах та ізометричному (рис. 

9.20). 

Для додавання відповідних розмірів щита потрібно перейти на 

вкладку «Пояснения» головної панелі та використовуючи меню 

«Размеры» вказуємо необхідні розміри (рис. 9.21). 
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Рис. 9.20. Оформлення креслення щита на стандартному аркуші 

 

 
Рис. 9.21. Процес додавання розмірів щита 

 

Для остаточного оформлення креслення щита необхідно 

заповнити основний напис у відповідності до ГОСТ 2.104-2006. 

Для цього потрібно натиснути підкатегорію «Текст в поле» в 

категорії «ГОСТ – Форма 1», що заходиться на лівій панелі 

робочого поля креслення (рис. 9.22). 
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Рис. 9.22. Меню заповнення основного напису креслення щита 

 

Після виконання всіх описаних операцій робота над 

розробкою креслення щита є завершеною 

 

Програма роботи 

1. Розглянути особливості розробки креслень з листового 

матеріалу та навчитися виконувати моделювання листових 

деталей за допомогою програми Autodesk Inventor. 

2. Виконати креслення щита за вказаними розмірами. 

 

Порядок виконання роботи 

1. Ознайомитися з правилами та особливостями креслення 

деталей з листового матеріалу з теоретичних відомостей. 

Зауваження. Завдання розраховано на виконання за дві 

лабораторні роботи. 

2. Частина 1 (с. 1-11). На основі даних з Додатку (див. 

Додатки. Додаток 1 до лабораторної роботи 9) визначити основні 

розміри (В×Ш×Г: Висота×Ширина×Глибина) щита за варіантом.  

3. За описом, який приведений у теоретичних відомостях 

виконати креслення всіх елементів щита (приклад розробки 

детально проілюстровано на рис. 9.1-9.13): корпус з отвором в 

нижній частині, двері, завіси та кріплення до них. Форма та 

вигляд елементів щита показано в Додатку (див. Додатки. 

Додаток 2 до лабораторної роботи 9).  
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Зауваження. Отвір виконуємо в нижній частині корпусу щита 

виконуємо довільного розміру, так як показано в Додатку (див. 

Додатки. Додаток 2 до лабораторної роботи 9). Величина 

елементів для побудови фланця (рис. 9.7) залежить від 

габаритних розмірів щита і визначається, як 1,5% (заокруглено до 

меншого значення) від висоти щита і є однаковою зі всіх сторін. 

Розмір дверей щита визначається, як різниця між висотою і 

шириною та величиною розміру фланця. Наприклад, якщо висота 

та ширина становить 710×310 мм, то висота і ширина дверей 

становить 700×300 мм. Заокруглення кромки дверей щита 

виконати довільних розмірів (рис. 9.11).  

4. Частина 2 (с. 11-16). Виконати зборку всіх елементів щита 

(щит, двері, завіси) так, як це описано у теоретичних відомостях 

(приклад виконання зборки детально проілюстровано на рис. 

9.14.-9.19). 

5. Виконати креслення розробленого щита на окремому 

аркуші стандартного розміру (А3-А1) з нанесенням розмірів та 

заповненим основним написом. Розмістити всі основні види та 

ізометричний вид так, як це показано на рис. 9.21.  

6. Результати проектування оформити у вигляді звіту на 

стандартних аркушах формату А4, а також надати виконаний 

файл/и елементів щита для перевірки виконання частини 1 та 

збірну конструкцію щита для перевірки виконання частини 2. 

 

Вимоги до оформлення звіту  

Звіт повинен містити: 

- титульний аркуш; 

- мету роботи; 

- програму та порядок виконання роботи; 

- скріншоти виконання основних етапів побудови, які описані 

у порядку виконання роботи (окремо для частини 1 і частини 2); 

- креслення розробленого щита на аркуші стандартного 

формату (А3-А1) з розмірами та заповненим основним написом 

(частина 2); 

- файл/и зі всіма елементами щита у форматі *.ipt (частина 1); 

- файл зборки щита у форматі *.iam (частина 2); 

- висновок. 
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Контрольні запитання. 

1. Як можна використовувати програму Autodesk Inventor для 

роботи з листовим тілом? 

2. Як здійснюється створення ескізу для подальшої побудови 

листового тіла ? 

3. Як створити фланець бокових сторін? 

4. Як виконується вирізання отворів у створеному листовому 

тілі? 

5. Як розробляються і додаються інші елементи конструкції 

щита (двері, завіси, кріплення та ін.)?  

6. Як відбувається формування креслення розробленого щита 

на стандартному аркуші? 
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Лабораторна робота 10 

Розробка 3D-моделей в програмі Autodesk Fusion 

 

Мета роботи 

Ознайомитися з інтерфейсом та особливостями креслення 3D-

моделей у програмі Autodesk Fusion. Навчитися використовувати 

основні операції з 3D-моделювання в програмі Autodesk Fusion.  

 

Теоретичні відомості 

Програма Fusion 360, або Autodesk Fusion - це хмарне 

програмне забезпечення, яке поєднує в єдину інтегровану 

платформу різні технології: конструювання (CAD); інженерних 

розрахунків та випробувань (CAE); виготовлення готових 

виробів (CAM) та розробка друкованих плат (PCB). Завдяки своїй 

універсальності програма Fusion дозволяє виконувати весь 

процесу розробки виробу в хмарному середовищі та працює на 

різних обчислювальних платформах. Хмарний характер 

програмного забезпечення дозволяє співпрацювати та ділитися 

проектом в режимі реального часу, що полегшує спільну роботу 

команди розробників незалежно від їх  місцезнаходження.  

Fusion містить різноманітні ресурси, які допомагають 

користувачам ефективно використовувати програмне 

забезпечення,  документацію, навчальні модулі та підтримку на 

форумі спільноти. Ключова особливість програми Fusion - це 

реалізація всього процесу створення виробу,  від прототипу до 

готового рішення. 

Основні функціональні можливості програми Fusion: 

- Виконання креслень. 

- Виконання 3D-моделей. 

- Розробка 3D-моделей з елементами поверхневого 

моделювання. 

- Зборки 3D-моделей.  

- Анімації зборок. 

- Розробка рендерів (з бібліотекою матеріалів, джерелами 

світла і текстурами). 

- Симуляція навантажень і розрахунок (CAE). 

- Створення машинного коду (G-коду) для фрезерування і 
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токарної обробки (CAM). 

- Робота з листовим матеріалом. 

- Створення електричних плат, з використанням бібліотек 

електронних компонентів. 

- Створення елементів генеративного дизайну. 

- Підготовка 3D-моделей для 3D-друку та ін. 

Процес створення 3D-моделей в Autodesk Fusion дуже 

подібний до такого ж процесу в програмі Autodesk Inventor. Тому 

в даній лабораторній роботі будуть розглянуті основні 

відмінності та операції, які відрізняються від операцій програми 

Autodesk Inventor.  

Після запуску програми потрібно створити новий проект, в 

якому будуть зберігатися файли. Створюється новий проект за 

допомогою вікна меню у вигляді квадратиків  у верхньому 

лівому кутку (Data Panel). Щоб почати новий проект потрібно 

натиснути на кнопку "New Project" та після цього, потрібно 

вказати назву проекту. 

Створення 3D-моделей відбувається у спеціальному робочому 

середовищі - Design, яке містить усі необхідні команди та 

операції. Для початку побудови з меню програми: «Solid > Create 

> Create Sketch» вибираємо площину побудови ескізу (рис. 10.1) 

та креслимо ескіз деталі за допомогою основних графічних 

примітивів, які доступні на вкладці Create після вибору робочої 

площини. А за допомогою меню Modify можна редагувати ескіз.  

 

 
Рис. 10.1. Створення ескізу 3D-моделі у програмі Fusion 
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Розглянемо приклад створення простої 3D-моделі подібно до 

тих, які розроблялися у лабораторній роботі 3. Використаємо 

один зі традиційних способів створення 3D-моделі – це 

креслення 2D-ескізу. Створення ескізу відбувається за подібною 

послідовністю та по аналогії розробки ескізів у програмі Autodesk 

Inventor. При цьому, використовуємо операції побудови основи 

деталі за допомогою примітиву Line, або Rectangle, округляємо 

кути командою Fillet, а також будуємо ескізи майбутніх отворів 

за допомогою команди Circle, та виконуємо їх симетричне 

проектування. Після завершення виконання ескізу натикаємо на 

кнопку  (рис. 10.2). 

 

 
Рис. 10.2. Процес побудови ескізу 

 

Для створення 3D-моделі паралелепіпеда переходимо на 

вкладку Create, вибираємо команду Extrude. У вкладці 

параметрів витискання задаємо відстань Distance, у нашому 

прикладі висота становить - 20 мм (рис. 10.3). Для створення 

інших елементів на 3D-моделі виконуємо операції, які подібні до 

операцій побудови моделі в програмі Autodesk Inventor.  
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Рис. 10.3. Побудова 3D-моделі з ескізу 

 

Виконуємо побудови отворів та вирізів формуючи на 

відповідних площинах деталі ескізи у вигляді кіл Circle, а потім 

витискаємо їх використовуючи команду Extrude, вказуючи при 

цьому параметри витискання на панелі налаштувань команди 

(рис. 10.4). Якщо потрібно виконати витискання у зворотному 

напрямку, то в віконці Direction вказати напрямок, або у віконці 

Distance перед величиною витискання можна вставити знак “-”. 

Процес видалення елементів з моделі подібний до витискання. 

Наприклад для видалення елементу циліндра зі вже створеного 

циліндра на його площині будуємо ескіз кола, яке буде основою 

для видалення циліндра за допомогою команди Extrude. 

Подібним чином можна видаляти інші елементи зі вже 

побудованої 3D-моделі.   
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Рис. 10.4. Процес побудови отворів 

 

Для побудови додаткових елементів 3D-моделі, або її 

модифікації можна використовувати подібні принципи побудови, 

як при кресленні 3D-моделей в програмі Inventor. Наприклад, для 

додавання опори циліндра до паралелепіпеда створюємо на його 

площині ескіз майбутньої фігури (рис. 10.5, а), потім виконуємо 

її побудову за допомогою команд, що знаходяться на вкладці 

Сreate, наприклад Extrude (рис. 10.5, б). Після цього, за 

допомогою контекстного меню задаємо необхідні параметри 

нового елемента 3D-моделі. Потім виконуємо її редагування за 

шляхом видалення непотрібних елементів (рис. 10.5, в). 

 

 
а 
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б 

 

 
в 

Рис. 10.5. Процес створення додаткових елементів деталі 

 

Для оформлення готового креслення на аркушах паперу 

відповідного формату та нанесення розмірів потрібно у 

головному меню вибрати “New Drawing > From Design”. У новій 

вкладці, яка з’явиться потрібно вибрати основний вид та додати 

необхідні види при потребі за допомогою опції меню Рrojected 

View. Заповнення та редагування основного напису відбувається 

подвійним клацанням на відповідному місці (рис. 10.6). 

Нанесення розмірів здійснюється за допомогою вкладки 
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Dimensions, або шляхом автоматичного формування розмірів 

Auto Dimensions (рис. 10.7). 
 

 
Рис. 10.6. Створення креслення деталі 

 

 
Рис. 10.7. Нанесення розмірів в автоматичному режимі за 

допомогою опції Auto Dimensions 

 

Процес додавання деталі до спільного проекту. Для того, 

щоб додати 3D-модель до спільного проекту потрібно бути 
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учасником групи з якою ви бути розробляти спільний проект. У 

даній лабораторній роботі проект створює викладач. Щоб 

дізнатися чи ви є в цій групі робимо наступні дії: Запускаємо 

Fusion > Натискаємо на кнопку в лівому кутку  > Після цього 

в верхньому лівому кутку буде вказано в яких групах ви є (рис. 

10.8). Якщо вас немає в групі зверніться до викладача, щоб вас 

додали до відповідної групи. 

 

 
Рис. 10.8. Приналежність до проектів та груп користувача 

 

Після закінчення вашої частини проекту потрібно його 

зберегти в папці групи (папку можна створити кнопкою New 

Folder ) для цього потрібно виконати наступні дії: 

натискаємо кнопку File > Save (якщо ви ще не зберігали проект) 

Save as (якщо проект уже збережено) > обираємо назву проекту 

та місце збереження. Після цього ваша 3D-модель буде додана 

до проекту (рис. 10.9). За подібним алгоритмом зберігаємо та 

додаємо креслення деталі на аркуші формату до проекту. 
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Рис. 10.9. Процес зберігання проекту та додавання його до групи 

 

Розглянуті у даному прикладі основні принципи розробки 3D-

моделей дають змогу навчитися виконувати побудови різних за 

складністю об’ємних конструкцій з використанням програми 

Autodesk Fusion. 

 

Програма роботи 

1. Ознайомитися з принципами та правилами побудови 3D-

конструкцій у програмі Autodesk Fusion. 

2. На основі описаних у теоретичних відомостях операцій та 

команд виконати побудову 3D-деталі за варіантом. 

 

Порядок виконання роботи 

1. Розглянути приклад створення 3D-моделі у програмі 

Autodesk Fusion, який описано у теоретичних відомостях. 

2. Створити новий проект вказавши його назву та ввівши 

основні дані розробника. 

3. Використовуючи варіант деталі, що виконана у лабораторній 

роботі 3, розробити 3D-модель за допомогою операції та команди 

програми Autodesk Fusion, що розглянуті у теоретичних 

відомостях. 

4. Виконати оформлення готового креслення 3D-моделі на 

аркушах паперу формату А3 розмістивши головні види (спереду, 
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збоку, зверху) та ізометричний вид так, як це показано на рис. 10.6 

(залежить від розміру моделі).  

Зауваження. Якщо розроблена 3D-модель не поміщається на 

форматі А3, тоді використайте відповідний масштаб зменшення. 

5. Нанести всі необхідні розміри та заповнити основний напис 

креслення.  

6. Результати роботи оформити у вигляді звіту на стандартних 

аркушах формату А4, а також надати виконаний файл 3D-моделі 

у форматі .f3d для перевірки. До звіті необхідно додати креслення 

деталі у трьох стандартних виглядах (спереду, збоку, зверху) та 

ізометричний (3D- модель) на окремому аркуші стандартного 

розміру А3 з вказаними розмірами та заповненим основним 

написом у форматі .f2d. 

 

Вимоги до оформлення звіту  

Звіт повинен містити: 

- титульний аркуш; 

- мету роботи; 

- програму та порядок виконання роботи; 

- скріншоти виконання основних етапів побудови, які описані 

у порядку виконання роботи; 

- креслення 3D-моделі на окремому аркуші стандартного 

розміру А3 з нанесеними розмірами та заповненим основним 

написом; 

- файл 3D-моделі у форматі .f3d (надати посилання, або додати 

в робочу групу АКІТ); 

- файл креслення деталі у трьох стандартних виглядах 

(спереду, збоку, зверху) та ізометричний (3D- модель) у форматі 

.f2d (надати посилання, або додати в робочу групу АКІТ); 

- висновок. 

 

Контрольні запитання. 

1. Як виконати розробку ескізу 3D-моделі у програму 

Autodesk Fusion? 

2. Як виконати розробку 3D-моделі у програму Autodesk 

Fusion? 

3. Як відбувається створення та редагування елементів до 3D-
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моделі? 

4. Яка особливість та способи використання функції 

побудови креслення та нанесення розмірів у програмі Autodesk 

Fusion? 

5. Як відбувається оформлення креслення 3D-моделі у 

програму Autodesk Fusion? 
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Лабораторна робота 11 

Розробка 3D-моделі робота-маніпулятора в програмі 

Autodesk Fusion 

 

Мета робота 

Ознайомитися з особливостями розробки 3D-моделі робота-

магіпулятора у програмі Autodesk Fusion. Навчитися 

використовувати операції 3D-моделювання в програмі Autodesk 

Fusion для розробки складальних одиниць.  

 

Теоретичні відомості 

Промисловий робот-маніпулятор має технічні параметри, які 

визначають його сферу використання та специфіку роботи. До 

основних технічних параметрів робота-маніпулятора 

відносяться: вантажопідйомність, точність позиціонування, 

призначення, тип керуючої програми, мобільність, форма і 

розміри робочої зони та кількість ступенів вільності. 

Серед найважливіших параметрі роботів-маніпуляторів є: 

1. Кількість ступенів вільності - це кількість можливих рухів 

маніпулятора відносно опорної системи робота. Зазвичай 

визначається числом ступенів свободи кінематичного ланцюга 

відносно нерухомого елемента (опори).  

2. Робоча зона - це об’єм простору, в якому знаходиться 

робочий орган (наприклад, захватний пристрій) під час 

виконання роботом його функцій. 

Комп'ютерне 3D-моделювання при проектуванні роботів-

маніпуляторів використовується для моделювання та візуалізації 

самих роботів так і процесів та операцій, які виконуються при їх 

застосуванні. У свою чергу, застосування комп'ютерної анімації 

дозволить розробити алгоритми роботи роботів, визначити 

циклограми їх переміщень та ефективно розробляти робочі зони 

роботів та технологічних процесів з їх використанням.   

Розглянемо приклад розробки 3D моделі робота UR10 від 

фірми Universal Robots, який показано на рис. 11.1. Детально про 

конструкцію та параметри цього робота можна ознайомитися на 

сторінці виробника за посиланням https://www.universal-

robots.com/products/ur10e/ 
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Рис. 1. Зовнішній вигляд промислового робота UR10 

 

В процесі виконання 3D-моделі звернуто увагу на основні 

елементи конструкції та способи їх побудови. Спочатку 

розробляємо платформу (основу), для цього проектуємо 

квадратну основу з виїмками під кріплення та витискаємо її (рис. 

11.2). 

 
Рис. 11.2. Ескіз основи робота 

 

Створюємо 3D -модель основи шляхом виконання команди 

витискання SOLID>EXTRUDE (рис. 11.3). Після цього виконуємо 

операції над отворами кріплення (рис. 11.4, а) та вирізаємо пази 

під отвори кріплення, як на рис. 11.4, б. 
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Рис. 11.3. Зовнішній вигляд 3D-моделі основи 

 

    
а                                         б 

Рис. 11.4. Зовнішній вигляд та розміри пазів  

 

Після цього створюємо на 3D моделі основи ескіз першого 

елементу у вигляді кола (рис. 11.5), потім витискаємо цей ескіз за 

командою SOLID>EXTRUDE та створюємо на ньому фаску. У 

результаті отримаємо 3D-модель основи, як це показано на рис. 

11.6. 

 

 
Рис. 11.5. Ескіз підвищення основи 
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Рис. 11.6. Остаточний вигляд основи 3D-моделі маніпулятора 

 

Після завершенню побудови основи переходимо до розробки 

кисті маніпулятора. Для цього проектуємо два звичайних 

циліндри однакового розміру, один відносно другого 

розташовується під кутом 90° (рис. 11.7). 

 

 
Рис. 11.7. Зовнішній вигляд циліндрів кисті маніпулятора 

 

Після цього, на верхній площині циліндра креслимо ескіз у 

вигляді кола (задаємо ширину стінки) та місця під болтове 

з’єднання, при цьому потрібно додати поверх кола діаметр різьби 

болта та додаткове коло яке є стінкою в якій буде зовнішня різьба 

(рис. 11.8). 

 



 

153  

 
Рис. 11.8. Процес побудови елементу кисті робота 

 

Далі виконуємо команду витискання у результаті якої маємо 

креслення бокового циліндру у якому теж виконуємо витискання 

тільки до середини основного циліндра, так як показано на рис. 

11.9. 

 
Рис. 11.9. 3D модель з’єднаних циліндрів з витиснутими 

частинами 
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Після виконання певних маніпуляцій у верхньому циліндрі, 

виконуємо зріз та виконуємо ще одне витискання (рис. 11.10). 

 
Рис. 11.10. Виконання зрізів 

 

Далі розробляємо ще один циліндр, який буде перетворений у 

кришку та робимо в ній отвори під болти. Верхня площина 

кришки теж не паралельна поверхні фіксації, тому її також 

зрізаємо під кутом та робимо фаску (рис. 11.11). 

 

 
Рис. 11.11. Зовнішній вигляд зрізаного конуса 

 

Робимо знизу відповідний зріз для формування щільного 

прилягання кришки до кисті, виконуємо витискання та робимо 

потайні отвори вручну, кожен окремо (рис. 11.12.) 
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Рис. 11.12. Виконання отворів 

 

Після виконання всіх окремих елементів виконуємо їх 

збирання. Для цього, додаємо до платформи основи всі 

розроблені компоненти, для цього використовуємо операцію 

«Insert component» , що в меню ««Insert» та додаємо 

першу кисть, як це показано на рис 11.13.  

 

 
Рис. 11.13. Додавання елементів зборки 
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Далі необхідно виконати об’єднання елементів зборки, для 

цього натискаємо кнопку «joint» , що на вкладці 

Assemble. Спочатку обираємо контур елементу, що приєднуємо, а 

потім контур елемента до якого приєднуємо. При цьому, 

отримуємо об’єднані деталі з відповідним символом (рис. 11.14). 

 

 
 

 
 

 
Рис. 11.14. Послідовність об’єднання деталей 

 

В розглянутому прикладі ми використовуємо два види 

об’єднання: «Rigid» і «Revote». Rigid - це статичне приєднання, 

тобто елементи об’єднані таким чином ніяк не можуть рухатися 
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один відносно одного, наче вони склеєні, а Revote вид об’єднання 

в якому всі компоненти мають здатність повертати один відносно 

одного. Rigid є стандартним методом об’єднання, а в Revote є 

декілька налаштувань. При застосуванні цих команд потрібно 

врахувати ступені вільності робота для розробки його анімації. 

Після виконання об’єднання, праворуч з’являється вікно 

налаштування, для зміни виду об’єднання, у якому необхідно 

перейти в вкладку «Мotion» і у випадаючому меню вибрати 

відповідний вид (рис. 11.15). 

    
Рис. 11.15. Використання функції об’єднання та створення видів 

 

Для першого вузла достатньо вибрати тільки вид з’єднання 

«Revote», оскільки по замовчуванню він має обертання без 

обмежень. Якщо все виконано правильно, тоді з’явиться значок 

об’єднання та елемент керування поворотом. Для виконання 

натисніть двічі на цей елемент і після цього його можна 

повернути. За тим самим алгоритмом додаємо ще одну кисть, але 

з додатковими налаштуваннями з’єднань (рис. 11.16).  
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Рис. 11.16. Процес додавання кисті 

 

Оскільки цей вузол буде повертати весь маніпулятор по осі Х, 

при умові що він буде знаходитись на опорі. Фізично він зможе 

повернутися тільки на 90° в одну сторону та 90° в іншу до 

паралельності маніпулятора його основи кріплення. Саме це 

задаємо в налаштуванні з’єднання.  

Для того, щоб виконувалась ця дія, потрібно у налаштуваннях 

увімкнути функцію Minimum, Maximum та вказати відповідні 

кути повороту (рис. 11.17). Важливо розуміти, що ці величини 

залежать від початкового розміщення елементів, тому необхідно 

правильно їх виставити перед об’єднанням. Після цього, наш 

елемент може повертати тільки на 180°. За подібним алгоритмом 

збираємо увесь маніпулятор.  

 

 
Рис. 11.17.Налаштування кутів повороту у функції Revolute 
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Продовжуємо виконання зборки додаючи кришки для першої 

групи кистей, та об’єднуємо їх за допомогою функції Rigid (рис. 

11.18).  

 

 
Рис. 11.18. Процес додавання кришок 

 

До сформованих елементів додаємо плече, при цьому 

початковий діаметр першої кисті повинен відповідати кінцевому 

діаметру елементу другої кисті. Поєднання елементів виконуємо 

за допомогою функції Rigid (рис. 11.19).  

  

 
Рис. 11.19. Процес додавання плеча 
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Після цього, приєднуємо кисть другої групи за допомогою 

з’єднання Revolet (рис. 11.20) та додаємо кришки. 

 

      
Рис. 11.20. Додавання елементів другої групи кріплень та 

кришок 

 

До кінцевої частини кисті робота додаємо елемент для 

кріплення захвату за допомогою з’єднання Revolet (рис. 11.21). 

 

 
Рис. 11.21. Додавання кріплення захвату 

 

Використовуючи остаточне поєднання всіх з’єднань 

отримаємо кінцевий вигляд робота маніпулятора (рис. 11.22). 
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Рис. 11.22. Кінцевий вигляд виконаної зборки всіх елементів 

 

У результаті всіх побудов та застосовуючи різнокольорове 

забарвлення для окремих елементів отримаємо 3D-модель 

робота-маніпулятора, яка показана на рис. 11.23. 

 

 

 
Рис. 11.23. Зовнішній вигляд виконаної 3D-моделі робота-

маніпулятора в програмі Fusion 
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Програма роботи 

3. Ознайомитися з принципами та правилами побудови 3D-

моделей роботів-маніпуляторів у програмі Autodesk Fusion. 

4. За допомогою описаних у теоретичних відомостях 

операцій та команд виконати побудову 3D-моделі за варіантом. 

 

Порядок виконання роботи 

8. Розглянути приклад створення 3D-моделі у програмі 

Autodesk Fusion, який описано у теоретичних відомостях. 

9.  Створити новий проект вказавши його назву та ввівши 

основні дані розробника. 

10. Використовуючи варіант моделі робота-маніпулятора за 

вказівкою викладача (використовуються реальні моделі), 

розробити 3D-модель робота-маніпулятора без захватного 

пристрою за допомогою операції та команди програми Autodesk 

Fusion, що розглянуті у теоретичних відомостях. 

4. Виконати оформлення готової 3D-моделі на аркушах паперу 

формату А3 розмістивши головні види (спереду, збоку, зверху) та 

ізометричний вид.  

5. Результати роботи оформити у вигляді звіту на стандартних 

аркушах формату А4, а також надати виконаний файл 3D-моделі 

у форматі .f3d для перевірки. До звіту необхідно додати креслення 

деталі у трьох стандартних виглядах (спереду, збоку, зверху) та 

ізометричний (3D- модель) на окремому аркуші стандартного 

розміру А3 з вказаними розмірами та заповненим основним 

написом у форматі .f2d. 

 

Вимоги до оформлення звіту  

Звіт повинен містити: 

- титульний аркуш; 

- мету роботи; 

- програму та порядок виконання роботи; 

- скріншоти виконання основних етапів побудови, які описані 

у порядку виконання роботи; 

- виконання 3D-моделі на окремому аркуші стандартного 

розміру А3 з нанесеними розмірами та заповненим основним 

написом; 
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- файл 3D-моделі у форматі .f3d (надати посилання, або додати 

в робочу групу АКІТ); 

- файл креслення деталі у трьох стандартних виглядах 

(спереду, збоку, зверху) та ізометричний (3D- модель) у форматі 

.f2d (надати посилання, або додати в робочу групу АКІТ); 

- висновок. 

 

Контрольні запитання. 

7. Як виконати розробку ескізу 3D-моделі у програму 

Autodesk Fusion? 

8. Як виконати розробку 3D-моделі у програму Autodesk 

Fusion? 

9. Як відбувається створення та редагування елементів до 3D-

моделі? 

10. Яка особливість та способи використання функції 

побудови креслення та нанесення розмірів у програмі Autodesk 

Fusion? 

11. Як відбувається оформлення креслення 3D-моделі у 

програму Autodesk Fusion? 
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ДОДАТКИ 

Додаток 1 до лабораторної роботи 1 

Розміри листів паперу формату ISO 216 

 

Міжнародний стандарт на паперові формати ISO 216 

заснований на метричній системі мір і походить від формату 

паперового листа, що має площу в 1 м² (розмір А0). Всі формати 

паперу ISO мають одне і те ж відношення сторін, це відношення 

приблизно дорівнює 1:1,4142. Цей стандарт був прийнятий всіма 

країнами, за винятком США і Канади та деяких інших країн. 

Формат ISO 216 складається з трьох серій форматів (з 

близькими розмірами для однакових номерів): 

А - за основу прийнята площа в 1 м² для максимального 

аркуша серії. 

В - за основу прийнята довжина в 1 м для короткої сторони 

максимального аркуша серії. 

С - формати конвертів для листів серії А (розміри більші 

приблизно на 9%). 

 

Форм

ат 

Серія A Серія B Серія C 

Розмі

р 

мм дюйми мм дюйми мм дюйми 

0 841 × 

1189 

33,11 × 

46,81 

1000 × 

1414 

39,37 × 

55,67 

917 × 

1297 

36,10 × 

51,06 1 594 × 

841 

23,39 × 

33,11 

707 × 

1000 

27,83 × 

39,37 

648 × 

917 

25,51 × 

36,10 2 420 × 

594 

16,54 × 

23,39 

500 × 

707 

19,69 × 

27,83 

458 × 

648 

18,03 × 

25,51 3 297 × 

420 

11,69 × 

16,54 

353 × 

500 

13,90 × 

19,69 

324 × 

458 

12,76 × 

18,03 4 210 × 

297 

8,27 × 

11,69 

250 × 

353 

9,84 × 

13,90 

229 × 

324 

9,02 × 

12,76 5 148 × 

210 

5,83 × 

8,27 

176 × 

250 

6,93 × 

9,84 

162 × 

229 

6,38 × 

9,02 6 105 × 

148 

4,13 × 

5,83 

125 × 

176 

4,92 × 

6,93 

114 × 

162 

4,49 × 

6,38 7 74 × 105 2,91 × 

4,13 

88 × 

125 

3,46 × 

4,92 

81 × 

114 

3,19 × 

4,49 8 52 × 74 2,05 × 

2,91 

62 × 88 2,44 × 

3,46 

57 × 81 2,24 × 

3,19 9 37 × 52 1,46 × 

2,05 

44 × 62 1,73 × 

2,44 

40 × 57 1,57 × 

2,24 10 26 × 37 1,02 × 

1,46 

31 × 44 1,22 × 

1,73 

28 × 40 1,10 × 

1,57 
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Додаток 2 до лабораторної роботи 1 

Види, товщини та призначення ліній за ISO 128 

 

Типи ліній, їх призначення і товщина встановлені 

стандартом ISO 128 (ДСТУ 2.307:2013). Суцільна товста основна 

лінія прийнята за вихідну. Товщина її S повинна вибиратися в 

межах від 0,6 до 1,5 мм. Вона вибирається в залежності від 

величини і складності зображення, формату аркуша та 

призначення креслення. Виходячи з товщини суцільної товстої 

основної лінії вибирають товщину інших ліній за умови, що для 

кожного типу ліній в межах одного креслення на всіх 

зображеннях вона буде однаковою. 

 

Назва 

Товщина 

відносно 

товщини основної 

лінії 

Основне призначення 

Суцільна 

товста 

S Лінії видимого контуру. Лінії переходу 

видимі. Лінії контуру перерізу 

(винесеного та вхідного до складу 

розрізу) 

Суцільна 

тонка 

Від S/3 до S/2 Лінії контуру накладеного перерізу. Лінії 

розмірні та виносні. лінії штрихування. 

Лінії-виноски. Полиці ліній-виносок і 

підкреслювання написів. Лінії обмеження 

виносних елементів на видах, розрізах і 

перерізах. Лінії переходу уявні. Сліди 

площин, лінії побудови характерних 

точок при спеціальних побудовах 

Суцільна 

хвиляста Від S/3 до S/2 
Лінії обриву. Лінії розмежування виду і 

розрізу 

Штрихова 
Від S/3 до S/2 

Лінії невидимого контуру. Лінії 

переходу невидимі 

Штрих-

пунктирна 

тонка 

Від S/3 до S/2 Лінії осьові та центрові. Лінії перерізів, 

що є осями симетрії для накладених або 

винесених перерізів 
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Штрих-

пунктирна 

потов-

щена 

Від S/3 до 2/3S Лінії, що позначають поверхні, котрі 

підлягають термообробці або покриттю. 

Лінії для зображення елементів, 

розташованих перед січною площиною 

Розімкне

на 

Від S до 1,5S Лінії перерізів 

Суцільна 

тонка із 

зламом 

Від S/3 до S/2 Довгі лінії обриву 

Штрих-

пунктирн

а з двома 

крапками 

тонка 

Від S/3 до S/2 Лінії згину на розгортках. Лінії для 

зображення частин виробів у крайніх або 

проміжних положеннях. Лінії для 

зображення розгортки, суміщеної з 

виглядом 
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Додаток 3 до лабораторної роботи 1  

Зразки ліній 

 

 

 

 

 

 

 

 

 

 

 

 

 

Назва Зразок лінії 

Суцільна товста  

Суцільна тонка  

Суцільна хвиляста 
 

Штрихова  

Штрих-пунктирна тонка  

Штрих-пунктирна 

потовщена 
 

Розімкнена  

Суцільна тонка із зламом 

 

Штрих-пунктирна тонка з 

двома крапками  
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Додаток 4 до лабораторної роботи 1 

Написи на креслениках згідно ГОСТ 2.304-81 

 

ГОСТ 2.304-81 регламентує написання літер кирилиці, 

латинського та грецького алфавітів, арабських та римських цифр. 

У цьому стандарті також наведені приклади написання деяких 

знаків. Шрифти розрізняють за розміром та типом. Розмір 

шрифту визначається розміром великої літери та береться з ряду: 

1,8; 2,5; 3,5; 5; 7; 10; 14; 20; 28; 40 

Рис. 7. Приклад написання літер української абетки 

креслярським шрифтом 

 

ГОСТ 2.304-81 встановлює типи шрифтів А та Б. Тип 

шрифту визначає товщину лінії накреслення шрифту. Цей 

параметр позначається літерою  d: для типу А — d = 1/14h; для 

типу Б — d = 1/10h. 

Дроби, показники, індекси і граничні відхилення 

виконуються відповідно розміром шрифту на один ступінь 

меншим, ніж розмір шрифту основної величини, до якої вони 

приписуються або однакового розміру з розміром шрифту 

основної величини. 

У програмі AutoCAD як стандартизовані можна 

використовувати шрифти видів: GOST type A, GOST type В, 

ISOCPEUR, ISOCTEUR, GOST 2.304 A, GOST 2.30481 type A, 

GOST 2.30481 type B тощо. 
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Додаток 1 до лабортаорної роботи 9 

№ Модель щита 
Розміри корпуса 

(В×Ш×Г), мм 

1 ЩРн-48з-0 36 УХЛ3 IP31 PRO 710×310×130 

2 ЩРн-12з-0 36 УХЛ3 IP31 PRO 335×310×130 

3 ЩРн-24з-0 36 УХЛ3 IP31 PRO 460×310×130 

4 ЩРн-2x24з-0 36 УХЛ3 IP31 PRO 600х460х130 

5 ЩРн-2x36з-0 36 УХЛ3 IP31 PRO 600х585х130 

6 ЩРн-2x48з-0 36 УХЛ3 IP31 PRO 600х710х130 

7 ЩРн-36з-0 36 УХЛ3 IP31 PRO 585×310×130 

8 ЩРв-12з-3 36 УХЛ3 IP31 TREND 230x275x125 

9 ЩРв-18з-3 36 УХЛ3 IP31 TREND 230x405x125 

10 ЩРв-24з-1 36 УХЛ3 IP31 360x275x125 

11 ЩРв-48з-1 36 УХЛ3 IP31 585x275x125 

12 ЩРв-36з-1 36 УХЛ3 IP31 505x275x125 

13 ЩРв-36з-1 58 УХЛ3 IP31 540х310х120 

14 ЩРв-54з-1 36 УХЛ3 IP31 540х440х120 

https://www.skad.com.ua/korpus_metallicheskiy_raspredelitelnyy_shchrn-2x36z-0_36_uhl3_ip31_pro/
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15 ЩРв-72з-1 36 УХЛ3 IP31 505x565x125 

16 ЩРВ-П-18 252х398х102 

17 ЩРВ-П-36 503х342х102 

18 ЩРВ-П-4 222х136х92 

19 ЩРВ-П-8 222х208х92 

20 e.mbox.stand.n.f3.36.z 335x580x160 

21 e.mbox.stand.n.f3.12.z.e 275x470x160 

22 e.mbox.stand.n.f3.24.z 330x470x170 

23 e.mbox.stand.n.f3.24.z.е 330x510x110 

24 e.mbox.stand.n.f3.36.z.e 335x580x115 

25 ЩРВ-П- 4 PRIME 210х162х102 

26 ЩРВ-П-12 PRIME 210х306х102 

27 ЩРВ-П-18 PRIME 210×414×102 

28 ЩРВ-П-24 PRIME 360×306×102 

29 ЩРВ-П-6 PRIME 210×198×102 

30 ЩРВ-П-9 PRIME 210×252×102 

https://www.skad.com.ua/boks_vnutrenney__ustanovki_shchrv-p-4/
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Додаток 2 до лабораторної роботи 9 
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